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The File Management
Tools (see page 63)

HP 16600A/16700A Series Logic Analysis System

e Making Measurements (see page 97) - Setting up a measurement, loading
a config file, etc.

e Measurement Examples (see the Measurement Examples help volume) -
Setting up common measurements.

e Using Measurement Tools (see page 73) - Instrument, Analysis, Display,
Emulation and Utility tools.

e System Overview (see page 93) - Getting to know your logic analysis
system.

e System Administration (see page 16) - Setting up and maintaining your
logic analysis system.

e (Connectivity (see the PC Connectivity help volume) - Netscape, Home
Page, Remote Front Panel, and the RPIL.

e Getting Help (see page 91) - Available help resources and searching for
help.

&

Use the File Manager to perform the common tasks of loading or
saving measurement configurations and data. The File Manager can
access both the flexible disk and internal/external hard drives.

e (reate, Delete, or Rename a Directory (see page 63)
e Load, Save, Copy, Delete, Move, Rename, or Compress a File (see page 63)

e Other File Manager Operations (see page 63)




The Intermodule
Window (see page 12)

The Workspace
Window (see page 14)
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The Intermodule window graphically depicts the internal arming
sequence between measurement modules and any external trigger
connections to a target system. With multiple instrument
measurements, use the Intermodule window to adjust the order of
trigger arming, and to compensate for timing skew between the
modules.

"

Example - Multiple Instrument Measurement (see page 123)

Example - Multiple Analyzer Measurement (see page 130)

Configure Arming Control Between Instrument Tools (see page 135)
Configure Arming Control Between Analyzers (see page 137)

Configure External Triggering with the Port In/Out Signal (see page 119)
Adjusting Intermodule Skew (see page 112)

Understanding the Run/Group Run Function (see page 147)

The Workspace window shows a graphical layout of your measurement
configuration. Use the Workspace window to alter your measurement
by adding or deleting tools, or by changing the data flow connections
between tools.

Adding Tools to a Measurement Configuration (see page 174)

Deleting Tools from a Measurement Configuration (see page 174)

Changing the Connections between Tools (see page 175)




The System
Administration Tools
(see page 16)

The Setup Assistant
(see the Setup
Assistant help
volume)

See Also

Use the System Administration tools to set up system defaults,
configure network connections, and perform maintenance on the
operating system file set.

e Network Setup, File System Connectivity, and Network Utilities (see
page 16)

e Product Licensing, Printer Setup, Time/Date, and Self-Test (see page 16)
e User Accounts and Changing Passwords (see page 17)
e Installing, Listing, and Removing Software (see page 17)

e Saving and Reloading System Settings (see page 45)

The Setup Assistant is an automated tool for connecting and
configuring your logic analyzer for processor measurements. This
menu-driven tool helps you connect and configure an analysis probe,
an emulation probe, or a source viewer.

e [Using the Help System (see the Help On Help help volume)
e Online Help Information on the World Wide Web (see page 91)
e Japanese Help Volumes (see page 99)

e (lossary of Terms (see page 179)
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Chapter 1: HP 16600A/16700A Series Logic Analysis System
The Intermodule Window

The Intermodule Window

Jr——

The Intermodule window shows a graphical representation of the
internal arming sequence between measurement modules, and any
external trigger connections to a target system or other instruments. In
measurements using multiple instruments tools or analyzers, the
Intermodule window is used to modify the order that measurement
modules are armed to trigger, and to compensate for any timing
deviations (skew adjust) between the modules probing.

The purpose of using multiple instruments or analyzers in the same
measurement is generally for two reasons. The first is to capture
different types of system data at the same point in time. The second
reason is to trigger the measurement from one type of data while
capturing a different type.

For example, you might have a timing analyzer trigger on a glitch, and
at the same time, signal an oscilloscope to capture the glitch and a
state analyzer to capture the program flow around the glitch.

e QOverview of a Multiple Instrument Configuration (see page 140)

e Overview of a Multiple Analyzer Configuration (see page 138)

e Using a Timing Analyzer and an Oscilloscope (see page 123)
e Using Both Analyzers (see page 130)
e Port In - Starting Measurements from External Triggers (see page 119)

e Port Out - Triggering External Instruments (see page 120)

e Using the Correlation Dialog (see page 110)
e  Run/Group Run Function (see page 147)

e Adjusting Intermodule Skew (see page 112)

12



Chapter 1: HP 16600A/16700A Series Logic Analysis System
The Intermodule Window

e  Group Run Arming Tree (see page 135)
e Arming Tree (see page 137)
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The Workspace Window

"

The Workspace window is a graphical layout of the measurement
configuration. In the more complex measurements, the Workspace is
used to change the configuration by adding or deleting tools, or by
changing the data flow connection scheme between tools.

Adding or Deleting Tools (see page 174)

e (Connecting Tools Together (see page 175)

e Repositioning Tools in the Workspace (see page 177)
e (learing the Workspace (see page 176)

¢ Loading Configuration Files (see page 81)

e Saving Configuration Files (see page 83)

e Printing Windows - Configurations (see page 37)
Print Options (see page 41)
Run All Function (see page 147)

“Workspace Options” on page 14

Workspace Options
The following options are available in the Workspace window.

Grid Mode

When Snap Grid is turned on, tool icons are always positioned
(snapped) to a grid layout. When the Snap Grid is turned off, tool
icons can be placed or moved anywhere on the workspace. To see the
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grid lines used with the Snap Grid, select Toggle Grid Lines.

Auto Arrange Icons

When Auto Arrange Icons is selected, all tool icons on the workspace
are automatically placed on a grid layout.

Screen Saver

When the Screen Saver is used, the display goes dark after the
selected time period. The display reappears after the mouse is moved,
or, any key on the keyboard is pressed.

15
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The System Administration Tools

The System Administration Tools window is where you set up system
defaults, network configurations, and perform maintenance on the
operating system file set.

Analysis System Network Setup
“Configuring the Network” on page 17
“Using the Name Resolver to Alias IP Addresses” on page 21
Windows 95/NT File System Connectivity
“Mapping Windows/NT Network Drives” on page 22
“Share Analyzer Drive” on page 27
“Configuring the NF'S” on page 30
Network Utilities
“FTP (file transfer protocol)” on page 34
“Telnet” on page 35

“Ping” on page 36

Licensing Products (see page 36)
“Printer Setup” on page 38
Other Printer Functionality
“Printing Windows - Configurations” on page 37

Printing to a File (see page 41)
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“Print Options” on page 41
“Configuring the System Clock” on page 43
“Running the Self Tests” on page 43

“Saving and Reloading System Settings” on page 45

“Setting Up User Accounts” on page 51

“Change Password” on page 57

Network Services
“Web Server Security” on page 58
“Shared Console (VNC) Security” on page 58
“Remote Programming Interface Security” on page 58

“penfsd (For PC NFS) Security” on page 59

“List Installed Software” on page 60
“Install Software” on page 59

“Remove Installed Software” on page 59

NOTE:

Configuring the Network

This operation may require System Administration Privileges. (see
page 18)

You configure a network to set connectivity between all other networks
and computers on those networks. With a properly configured network,
you can interact with other computers to run the logic analysis system
as well as perform file operations or run programs on other computers.

17
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Network Setup

1. From the Networking tab in the System Administration Tools window, click
Network Setup ....

Click Networking Enable.

Type the Hostname (see page 19).

Type the Internet Address (IP) (see page 19).
Type the Gateway Name (see page 19).

Type the Gateway IP (see page 20).

Type the Subnet Mask (see page 20).

® N o otk

Click OK.

To start the network setup from the factory default settings, click Default
Network before performing the steps above.

“Using the Name Resolver to Alias IP Addresses” on page 21

“Emulation Network Setup” on page 20

System Administration Privileges

Your System Administrator is the first person who accesses the User
Accounts dialog and gives himself system administration privileges.
From that point forward, the User Accounts... pick is unavailable for all
users except the users with system administration privileges. There
can be more than one System Administrator. However, the first
administrator must initially give all other administrators privileges so
they can gain access to the restricted areas when they login the first
time. If User Accounts are not used, all users have system
administration privileges.

At the time users login, the system software checks for system
administration privileges and sets the appropriate access mask on all
restricted areas of the system.

Only the System Administrator can perform the following system-level
tasks:

18
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e (Configure the network.

e Enable or Disable the Secure Mode and the use of user accounts.
® Add and remove individual user accounts.

e Set the system-wide default file permissions (see page 88).

e Set user permissions for new file creation.

e Set the system time.

e Set NF'S export permissions from the logic analysis system.

Hostname

The Hostname is the name of your local computer or logic analysis
system. The name can contain only lower case letters, numbers,
underscores(_), and dashes(-). It must start with a lowercase letter.
Get the hostname from your system administrator.

Hosthname

[lrnprodé

Internet Address (IP)

The Internet Address (IP) is a four-part code in integer dot notation.
The assignment of an internet address uniquely identifies your
computer among all those located on your network or any other
network. Get this IP address from your system administrator.

Internet Address{(IP} 15.6.255.122

“Using the Name Resolver to Alias IP Addresses” on page 21

Gateway Name

The Gateway name is the name of the computer that routes traffic
from one network to another. If you plan to communicate with a
computer on a different network, you must specify the gateway
computer name. No entry in this field will disable the gateway. The
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gateway name can contain only lowercase letters, numbers,
underscores(_), and dashes(-). It must start with a lowercase letter.
Get the gateway name from your system administrator.

Gateway name | colgwl.col.hp.com

Gateway IP

The Gateway IP is a four-part code in integer dot notation. The
assignment of the gateway IP allows the logic analysis system to
connect between other networks and subnetworks. The gateway IP
must be set to the address of the gateway machine. No entry in this
field will disable the gateway. Get the gateway address from your
system admanistrator.

Gateway IP |15.6.248.1

Subnet Mask

The Subnet Mask is an assigned group of bits that helps to quickly
identify your subnetwork. If you have a gateway machine and your
network is partitioned into subnetworks, you must specify a subnet
mask. The subnet mask is a four-part code in integer dot notation. An
example of an 18-bit subnet mask is shown below. Get the subnet mask
from your system administrator.

Subnet Mask |255.255.248.0

Emulation Network Setup

Emulation probes, both standalone and interconnected to an emulation
module, need to be configured with LAN parameters.

The procedure for starting an connecting an emulation probe to the
network depends on which kind of emulator you are using:

20
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e Setting Up an ES900A Emulation Probe (see the Emulation: Setting Up
help volume)

e Setting Up an E5900B Emulation Probe (see the Emulation: Setting Up
help volume)

e Setting Up an E5901B Emulation Module (see the Emulation: Setting Up
help volume)

An easy way to configure an emulation probe is to use the Setup
Assistant. Use the Setup Assistant if:

e You have a single E5900B emulation probe interconnected to an E5901B
emulation module, or

e You have an emulation probe and NO emulation module is installed in your
logic analysis system.

The Setup Assistant will not allow you to set up a standalone emulation
probe if an emulation module is installed.

e  Using an EB901A Emulation Module on Your LAN (see the Emulation:
Setting Up help volume)

e To obtain LAN information (see the Emulation: Setting Up help volume)

e The Setup Assistant (see the Setup Assistant help volume)

Using the Name Resolver to Alias IP Addresses

The Name Resolver is used to assign custom names (aliases) to the
Internet IP addresses. With an alias assigned to the Internet IP
Address, you simply type in the alias in any IP address field. The
configuration interprets it as the correct IP address. Alias names are
usually set in either a local Host Table or a Name Server on the
network.

1. From the Network Setup dialog, click Name Resolver....

2. In the Name Resolution Dialog, select Host Table and click the text entry
field for the alias names.

3. Type in the Internet IP Address (see page 19) followed by a space, and
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then the alias name.
4. Click Add.
5. Click OK.

Mapping Windows/NT Network Drives

The Map Windows Drive dialog is used to designate a share in a
Windows/NT computer to be available for file operations performed
from the logic analysis system.

NOTE: The logic analysis system only allows the use of one mapped directory per
server at a time. If more than one directory must be mapped, you must
disconnect the previously connected share before mapping the new one. Also,
do not disconnect a share mapping while files are being accessed. The
resulting file contention may cause long delays or an unstable logic analysis
system.

There are two ways to connect to a remote file system. One way is to
create a new connection. The other way is to reconnect to a previous
connection.
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Creating a New Connection

1.

Type in the Network Path (see page 25). The network path consists of the
IP address or the server name, followed by the specified share name.

Type in the Logic Analyzer Dir Path (see page 25).

Set the Reconnect at Startup (see page 24) as desired. When activated,
this feature automatically re-establishes the Windows/NT connectivity to
the logic analyzer directory at each new analyzer session startup.

Set the Read Only if necessary. See the note below.

Optional - Type in the Login Information (see page 25) if the share is
protected.

Optional - Click Advanced... to correct inconsistent naming (see page 26)
of the Windows netbios computer and the TCP/IP hostname.

Click Conmnect.

“woafedStmp

If the CD-ROM you are using is shared from a Windows 95 server, the Read
Only field must be enabled.
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Choose a Previous Connection

If a connection has been made in the past, the connection and its
options will appear in a dialog found by clicking the Previous... button.
To re-establish a previous connection, do the following.

1. Click Previous....

2. Select the desired connection from the list in the PC Previous Connections
dialog.

3. Click Select.

For security reasons, password information is not saved when the Previous
dialog is used. In this case, you are required to re-enter Share passwords.

Disconnect a Current Connection

A list of Current Connections appears at the bottom of the dialog.
This is a list of all connections to remote file systems. If you
Disconnect a share mapping when either a file is still open, or a file
operation is in progress, the resulting file contention may cause long
delays or an unstable system. Terminate all file operations and
interaction with the remote file system before you disconnect the share
mapping.

To disconnect a share mapping, click the desired connection in the
Current Connections list, and then click Disconnect.

Reconnect at Startup

If you plan to reconnect at each startup, make sure to enable the
feature when you configure the connection the first time. This field
cannot be edited. The only way to change the configuration is to
disconnect, and then configure as a new connection. Also, be sure to
keep the connection active when you exit a session. In other words, do
not select the Disconnect field at the bottom of the dialog when you
exit a session.

For security reasons, you cannot reconnect to a PC share map that is
password protected.
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Network Path

What you type into the Network Path field will take the form
\\computer_name\share_name, where computer_name is the IP
address or name of the Windows server you are connecting to.

You can locate the computer name by right-clicking on Network
Neighborhood under the Windows system, then selecting Properties
from the pull-down menu. Locate the tab labeled Identification and
the Computer Name is specified there.

The share_name is the name that was specified for the Share Name in
the share dialog on the server where the share was created. To find the
Share Name under a Windows system, go to the drive where the share
is located, right-click on the directory, then select Sharing from the
pull-down menu. The share name is specified in the dialog that
appears.

Logic Analyzer Directory Path

The Logic Analyzer Div Path points to the directory location in the
analyzer that is mapped to the Windows share. The directory is based
off of the main directory /Aplogic/. The default name given to the sub-
directory is the same as the Share Name designated in the Network
Path field.

Some characters such as "$" are not allowed in UNIX filenames. If a Share
Name has one of these characters in its name, the default Logic Analyzer Dir
Path will be illegal, and you must change it manually.

Login Information

The Login Information is only required if the share is password or
account protected, that is, it is NOT a public share. If the share is a
Windows 95 share, with ONLY password protection, typically only the
User Account/Share Password field is required. If the share is a
Windows N'T/95 share that is protected on a user account basis, the
User Account Name and User Account/Share Password fields are
both required. If the share is protected on a user account basis with NT
domain authentication, all fields are required.
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User Account Name

This field allows the user to specify what his login account name is.
This is required for a share that has its permissions based on user
accounts.

User Account/Share Password

This field allows the user to specify the password for either his
account, or just the password for a share that is password protected.
Note that this field will display "*" characters as you type your
password for security purposes.

If you are mapping to a Windows system, and after entering the User Account/
Share Password you have trouble connecting, try entering the Windows
Domain Name.

Windows Domain Name

This field allows the user to specify the name of the domain the user
account name should be authenticated under. This may be a necessary
field if the Windows server is using NT domain authentication.

Naming Server and Client Netbios Names

This operation may require the help of your System Administrator

Use the Advanced... field to access a dialog used to correct naming
inconsistencies between the Windows netbios computer name and the
TCP/IP hostname of the same computer. The logic analysis system
must be provided with the name that is specified under the Windows
netbios environment.

For example, a Windows PC with the computer name of "testpc" is
connected to a TCP/IP network with an internet address of "joe-
pc.company.com". Since "testpc" and "joe-pc" are different names, the
logic analysis system has no way of knowing the two names point to the
same computer.

26



NOTE:

Chapter 1: HP 16600A/16700A Series Logic Analysis System
The System Administration Tools

Server Nethios Name

This field is used to specify the netbios name of the Windows server PC
with the share you wish to map. This name can be found by right-
clicking on the Network Neighborhood icon on the server PC and
selecting Properties. The Identification tab in the dialog that appears
will show the name of the computer.

Client Nethios Name

This field is used to specify the netbios name of the logic analysis
system if it is different from the hostname specified in the Network
Setup dialog. You will need to contact your network administrator if
you do not know what the netbios name of the logic analysis system is.

For convenience, it is usually easier to make sure these two names are the
same so the Advanced... field is not necessary.

NOTE:

Share Analyzer Drive

The Share Logic Analyzer Divectory dialog is used to designate a
directory in the logic analysis system to be available for file operation
performed from a Windows/NT computer.

If you are configuring a Windows/NT share for the first time, your system
administrator may have to set up the appropriate permissions and security
on the remote computer.

There are two ways to share a logic analysis directory to remote
Windows/NT systems. One way is to create a new share. The other way
is to reconnect to a previous share.

Creating a New Share

1. Type the directory name that you want accessible from a Windows/NT
computer.

The directory you choose must be a sub-directory based off of /
hplogic/. You can also use the Browse field to access a graphical file
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manager to help in specifying a directory name.

o

Type in the Share Name (see page 29).

w

Optional - Type in a Share Comment (see page 30).

-~

Set the Reshare at Startup as desired. When activated, this feature
automatically re-establishes the share connectivity to the remote
Windows/NT computer at each new analyzer session startup. See the note
below.

5. Optional - Type in a Share Password (see page 30), and then retype the
password to verify it was typed correctly.

6. Click Share.

dept test configs H

If you plan to Reshare at each startup, make sure to enable the feature, and be
sure to keep the share as a current active share. In other words, do not select
the UnShare field at the bottom of the dialog when you exit a session.
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Choose a Previous Share

If a connection has been made in the past, the connection and its
options will appear in a dialog found by clicking the Previous... button.
To re-establish a previous Share, do the following.

1. Click Previous..
2. Select the desired Share from the list of PC Previous Connections.

3. Click Select.

For security reasons, password information is not saved when the Previous
dialog is used. In this case, you are required to re-enter Share passwords.

Disconnect a Current Share

A list of Current Shares appears at the bottom of the dialog. This is a
list of all remote file system connections that are sharing the file
system of the logic analysis system. If you UnShare a share mapping
when either a file is still open, or a file operation is in progress, the
resulting file contention may cause long delays or an unstable system.
Terminate all file operations and interaction with the remote file
system before you disconnect the share mapping.

To disconnect a current share, click the desired connection in the
Current Shares list, and then click UnShare.

Share Name

The Share Name is simply a literal name for the share. By default, a
name is assigned using the base name of the directory name. The base
name is the text to the right of the front-slash (/) in the path name.

Example:
If the directory name path you choose is /hplogic/test_1,
then the default Share Name would be test_1.

You can change the default name if you desire. Directory names can
only include the following alphanumeric characters:

O_9a a-z, A_Za (_)1 (+)7 (_)a ()a (/)) and ()
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Share Comment

Use the Share Comments field to tag a Share directory with a desired
note. Any Share Comment you type, is displayed with the Share Name
when browsing the logic analyzer directories from a remote Windows/
NT computer.

Using a Share Password

If a Share Password is used, the user of the Windows/NT computer
will be prompted to type in the password before being allowed to
perform file operations in the logic analyzer directory.

If no Share Password is used, the logic analyzer directory will have open
access with no file security.
Changing a Share Password

If a Share is set up to use a password, it will show up in the list of
currently active shares as being password protected. To change the
password on a currently active share, follow the procedure below.

To change an encrypted password, follow the procedure below.
1. Select the Share in the Current Shares list.
Select UnShare.

Select the Previous... field, and then select the Share from the list.

s~

Type in a Share Password, and then retype the password to verify it was
typed correctly.

5. Select Share.

Configuring the NFS

The NF'S Client Setup (Network File System) dialog lets you create
network connections to remote computers for the purpose of mounting
their file systems to your local logic analysis system.

The benefit of a mounted file system is that you can interact with the
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remote directories/files using the File Manager in the logic analysis
system. You also have the benefit of using the disk space in the remote
computer rather than the disk space in the logic analysis system.

After an NF'S connection is made, you will access the remote
directories/files under the /hplogic directory in the logic analysis
system.

If you are configuring an NF'S mount for the first time, your system
administrator may have to set up the appropriate permissions and security
on the remote computer.

There are two ways to connect to a remote file system. One is to create
a new connection. The other is to reconnect to a previous connection.

Creating a New Connection

1. From the Networking tab in the System Administration Tools window, click
Mount NF'S Filesystem ....

2. From the NF'S Client Setup dialog that appears, type in the Remote host:
(see page 32) name. Optional - Use Browse Hosts... (see page 33) to select
a remote host and a remote directory path from a predefined list.

3. Type in the Remote dir path: (see page 32).

4. Type the Local dir path: (see page 33). Optional - Use Browse Local...
(see page 33) to select a directory path from a predefined list.

5. Choose the desired Options... (see page 33).
6. Click Mount.

Choose a Previous Connection

If a connection has been made in the past, the connection and its
options will appear in the NF'S Previous Connections dialog, obtained
by clicking the Previous... button.

1. From the System Administration Tools window, click Mount NF'S
Sfilesystem....
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From the NFS Client Setup dialog that appears, click Previous....
Click the desired connection from the NEF'S Previous Connections list.

Click Select.

A e T

Click Close.

By choosing from the NF'S Previous Connections list, you
automatically get the defined options (see page 33) of that previous
connection.

Unmount a Current Connection

A list of Current Connections appears at the bottom of the NF'S Client
Setup dialog. This is a list of all connections to remote file systems that
your logic analysis system is currently mounted to. If you try to
disconnect a mount when either a file is still opened by you, or a file
manager operation is still in progress, you will get a Device busy error.
Terminate all of your interaction with the mounted file system before
you disconnect the mount.

To disconnect a current connection, click the desired connection in the
Current Connections list, then click Unmount.
Remote Host

The Remote host: field designates the remote computer’s name. It can
take the form of an alias, or a 4-part IP address integer. The remote
host name, plus the remote directory path, becomes the Network Path
listed in the Current Connections or NF'S Previous Connections lists.

Remote Directory Path

The Remote dir path: field designates a directory path on the remote
machine. Type the remote directory path in the text field.

Example

/hplogic/test
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Local Directory Path

The Local Directory field designates the local directory. If the local
directory you entered does not exist, a one-level directory is created
for you using the name you typed. Note that only one level will be
created automatically for you.

Example
/hplogic/test - where /test was created for you.

Options

e The Read/Write - Read only option determines if you can read or write to
the mounted file system.
If the exported file system is Read only, then you cannot have a Read/
Write option. It must be specified Read only.

e The Hard - Soft option determines if a request is continually repeated until
success (Hard), or if a request is made four (4) times, then aborts (Soft).

e The Reconnect at Startup options reconnects to the file system every
time the logic analysis system is turned on.
Using Browse Hosts

The Browse Hosts... field is used to access a predefined list of remote
host machine names and the directories that are mountable.

1. Click Browse Hosts...

2. From the Browse NF'S Hosts dialog, either select a host name from the
upper list, or type in a host name in the text entry field.

3. Click Show Directories.

4. Select the desired directory, and then click Select.

Using Browse Local

The Browse Local... field accesses a Local Directory Browser similar
to a file manager. Use this Local Directory Browser to build a directory
path.
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NOTE:

FTP (file transfer protocol)

Once you have established an FTP (file transfer protocol) connection,
you can perform FTP commands on files in both the logic analysis
system and a remote workstation, PC. If you are in Secure Mode, you
can only perform FTP commands from the logic analysis system.

The following example copies a password file to a remote system, and
then copies it back to the logic analysis system.

1. From the Networking tab in the System Administration Tools window, click
FTP ...

2. In the FTP Site dialog that appears, type the alias name or IP address of
the remote workstation, PC, or other logic analysis system, and click OK.
See the note below.

3. Inthe FTP window that appears, type your Login, and press the Enter key.
4. Type in your Password, and press the Enter key.

5. From the ftp window that appears, copy the example file
"password.example" to a directory in the remote system. For example: put
/local_etc/password.example /'remote_dir_name"/.

6. Copy the file back to the logic analysis system. For example: get /
"remote_dir_name"/'new_filename" /local_etc/.

To Terminate the FTP Session

To terminate your FTP connection, type "quit".

Alias names that are not located in /etc/host on your remote machine may not
be recognized by the logic analysis system. If this is the case, use the Internet
IP address instead of the alias name.

FTP Connection from PC to Logic Analysis System

Use this procedure if you want to make an FTP connection from a
remote PC or Workstation to the logic analysis system.
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An FTP connection from a remote PC or Workstation is not allowed when the
logic analysis system is in Secure Mode.

1. From the command line of your remote computer, type: ftp
"machine_name".

2. For the login name, use "anonymous".

3. For the password, use "nopass".

NOTE:

Telnet

The ability to Telnet (connect) to other workstations, PCs, or logic
analysis systems lets you run and view programs resident to these
remote machines. As an example, you can run multiple logic analysis
systems from the same display.

When identifying a remote machine during a telnet login process, you
can use either the Internet IP address (see page 19), or a predefined
alias name (see page 21). If you use an alias name, see the note below.

The following example shows how to Telnet to a remote logic analysis
system and display its session on your local logic analysis system.

1. From the system window in your local logic analysis system, click the
System Admanistration icon. Then from the Networking tab in the
System Administration Tools window, click Telnet ....

2. Type the name of the remote logic analysis system, and click OK.

3. From the Telnet window that appears, type "hplogic", and press the Enter
key.

"hplogic" will not work if the remote logic analysis system is in Secure Mode.
In this case, enter a login and password that is within the user accounts (see
page 51) of the remote logic analysis system.

4. From the Session Manager dialog of the new remote session, click Display
Session on Another Display.

5. From the Remote Setup dialog that appears, type the name of the local
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display, and click Start.

To Terminate the Telnet Session

To terminate your remote session, click Exit in the remote System
window. Then from the remote Session Manager window, click
Disconmnect. This will remove both the remote System window and
Session Manager window from the local display.

Alias names that are not located in /etc/host on your local machine may not be
recognized by the logic analysis system. If this is the case, use the Internet IP
address instead of the alias name.

Ping

Ping is a utility to check LAN communication with remote hosts. To
ping a remote host, simply type in the remote host machine name and
click OK.

To stop the pinging, type control-C.

Licensing Policy for the Logic Analysis System

License Policy:

Select logic analysis system product software is licensed for single use
only. Licenses are nodelocked and are valid for the life of the product.
Software updates do not affect the license.

Nodelock Mode:

Product licenses are shipped or first installed in nodelock mode.
Nodelock mode allows use of the product license only on the node
(HP 16600-Series or HP 16700-Series logic analyzer) on which it is
installed. Products ordered with a logic analysis system will be installed
and ready to run. Products purchased aftermarket will require
customers to access Agilent’s password redemption Web site to obtain
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the appropriate passwords. The Web site URL and alternate contact
instructions are provided on the Entitlement Certificate shipped with
the licensed product.

Temporary Licenses:

In most instances, a single temporary (demo ) license is available for
any product not previously licensed on a node. The temporary license
is valid for the number of calender days specified in the Demo Time
column. The demo time starts from first entry of the password in the
license management window. The temporary password for any node on
any tool set is "demo".

License Management:

Licenses are managed from the License Management window, obtained
by clicking Licensing... under the Admin tab in the System
Administration Tools window. License management does not require
Unix expertise. Licenses are reserved at the start of a measurement
session. They remain in use (reserved) until the measurement session
is terminated.

Password Backup:

Passwords can be backed up to floppy disk by selecting Save... under
the Admin tab in the System Administration Tools window. Passwords
can only be restored on the logic analysis system where they were
initially installed in nodelock mode.

NOTE:

Printing Windows - Configurations

The print windows operation lets you print either the current window,
all currently open windows, or just a selected window. Also if you are in
the Listing Display window, you can print data to a file.

When printing windows to a printer, only the currently displayed viewing area
of the window or computer screen is printed. If any data or configuration
fields appear off-screen, scroll the desired data or configuration fields into the
window’s viewing area before printing.
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Print this window

Print this window prints the current window.

Print all windows

Print all windows prints all open windows. This option is only
available in the Workspace window.

Print any window

Print any window prints any open window that you click on.

Print to file

Print to file prints data from the Display tool to a file. This option is
only available in the Listing Display window.

Setting Print Options (see page 41)

Setup the Printer (see page 38)

Printer Setup

Local Printer Setup

1. From the Admin tab in the System Administration Tools window, select
Printers ....

2. From the Printer Setup dialog that appears, click Local.
3. In the Printer type pulldown, select the printer type you are connecting.

4. Click OK.
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Network Printer Setup

Use this procedure if you are using a Unix print server. If you are using
a Windows NT print server, click this link. (see page 40)

1. From the Admin tab in the System Administration Tools window, select
Printers ....

2. From the Printer Setup dialog that appears, click Network.
3. Type in the recognized Printer name. See the note below.

4. Type in the recognized Print Server name. In addition to being listed in a
network host table, the print server name must be listed in the host table
(see page 21) in the logic analysis system.

5. In the Printer type pulldown, select the printer type you are connecting.

6. Click OK.

.
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Consult your system admanistrator for the required printer name and print
server name. These names should be located in the network’s host table or
name server. The print server name must also be listed in the host table (see
page 21) in the logic analysis system.

Windows NT Server Configuration

From the Windows Interface:
1. From the Main file group, select Control Panel, then Network.
2. Select the Services tab.

3. Click Add..., select TCP/IP Printing, and click OK. At this point, NT will
automatically install the Berkeley Unix LPD print server.

4. From the Control Panel, select Services.

5. From the Services control panel, select TCP/IP Print Server, and click
Startup....

6. Change Startup Type to Automatic.

7. Configure your printers on the NT machine as you normally would.
From the System Administration Tools Window:
Do not put white space in the printer name.

1. From the Admin tab in the System Administration Tools window, select
Printers ....

2. Click Network.
3. Type in the recognized Printer name. See the note below.

4. Type in the recognized Print Server hostname. In addition to being listed
in a network host table, the print server name must be listed in the host
table (see page 21) in the logic analysis system.

5. Select Yes to Berkeley UNIX server.
6. In the Printer type pulldown, select the printer type you are connecting.

7. Click OK.
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Status |ND printer configured, |

| + Local |

+ .
Network Printer: |lJ4lpt’1 3

Frint Server: |labSPDDl Izl

IE]IS print server Berkeley UNIX7? -« Ho

—

6]
Frinter type PCL {bswl —
Frinter Guesue 0 Cancel all |

m Ok | Cancel | Help |

Consult your system administrator for the required printer name and print
server name. These names should be located in the network’s host table or
name server. The print server name must also be listed in the host table (see
page 21) in the logic analysis system.

Print Options

The Print Window Options dialog lets you set print destination, file
format type, filename autoincrement, and color/b&w; pixel mapping.

1. In the tool window menu bar, click File, and Print Options.

2. From the Print Window Options dialog, select the destination as either
Printer or File.

3. If Printer is selected, configure the Printer Setup (see page 38) dialog.

w

If File is selected, type in the path and filename. You can also click Fle
and use the File Selection dialog to enter a path and filename.

Optional - If File is selected, autoincrement (see page 42) the filename.
Optional - If File is selected, select the file format type.
Set the Pixel Mapping (see page 42) to Color or Black & White.

Set the Orientation to Landscape or Portrait.

© »® 3 o o

Click Close.
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— /hplogic/conf—'igs/pll

e —

EE -

“Printing Windows - Configurations” on page 37

“Printer Setup” on page 38

“Windows NT Server Configuration” on page 40

Autoincrement filenames

Use the Autoincrement feature when you are saving multiple files, and
you don’t want to type in a new filename for each new file. As files are
saved, the base filename remains the same with only the extension
being incremented.

Example

filename.0
filename.1
filename.2
filename.3

Pixel mapping

Use the pixel mapping feature when you want to print a faxable black
and white hardcopy.
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NOTE:

Configuring the System Clock

This operation may require System Administration Privileges. (see
page 18)

1.
2.

From the System Administration Tools window, select Time/Date....

Click in the desired value field, and backspace or delete the current
numbers.

Type the new values, and click OK. At this point, you are asked to reboot
the logic analysis system.

Running the Self Tests

The Self Test function of the logic analysis system performs functional
tests on both the System and any installed modules.

1.

From the Admin tab in the System Administration Tools window, click
Self-Test....

Read the Question dialog and click Yes if you wish to run the self tests.

From the Self Test window, select the desired area to test by clicking on
the appropriate tab. Your choices are either the System boards, modules in
the Master Frame, or modules in the optional Expander Frame.

Run the tests in one of the following ways:

e Test All - To test all boards or modules under a tab, click Test All at the
bottom of the Self Test window.

e Test a single board or module — To test a single board or module under
a tab, select the desired board or module, and then select either a
single component or click Test All at the bottom of the board or module
test dialog.

When you are finished running self tests, select Quit. Then restart your
session from the Session Manager window.
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For complete information on self tests, test options, troubleshooting, and
service procedures, refer to the optional service guides available for the
system or the desired modules.

“More on Self Tests” on page 44

More on Self Tests

Self Test lets you get confidence that the hardware is configured and
operating correctly, and enables the HP factory to test the product.

Self Tests and Session Management

When Self Test is entered, the current measurement session is exited.
You are warned of this prior to entering Self Test so you can save any
important data and configurations. The closure of the measurement
session is necessary because Self Test leaves the hardware in an
unknown state when it is finished. Restarting the measurement session
is then required to properly initialize the hardware.

Testing Multi-Card Modules

Under each tab is a list of boards or measurement modules. When
selected, each individual board or module lists a set of its own
individual tests. Some measurement modules are composed of multiple
cards where one card is called the master and the others are called
expanders. Self tests for a multiple card set are always tested through
the master card. Test results for the expander cards will track results
for the master card. In some cases, the self tests can identify a problem
to either an expander or master card. In this case, the failure counts
shown on an expander card may differ from those shown for a master
card.

Test Options

Test options are set from the Options pulldown in the menu bar. They
are provided only as a convenience to the user. They are intended for
factory use only.
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User Action Required

When running "All Tests", some of the tests may have a test result of
"Not executed". In some cases, this message is because the test does
not apply to the current hardware configuration. In other cases, it
indicates the test requires some type of user action. These tests should
be individually selected, and when user action is required, a dialog will
appear to direct the user. The tests that require user action are listed
below.

CPU Board

e Floppy Drive Test: A DOS formatted floppy must be in the drive.

e External SCSI Test: A powered-up CD-ROM drive must be on the bus.
HP16517A Timing Module

e Skew Adjust: Not a test; used for calibration.

HP16522A Stimulus Module

e QOutput Stimulus Vectors: Not a test; provides continuous signal output.
HP16534A Scope Module

e ADC Test: There must be no stimulus on the scope inputs.

HP16550 State and Timing Module

e Show Activity: Not a test; provides continuous output of signal input
levels.

HP16610A Emulator Module
e Internal PV Test: A loop back connector must be installed.
For complete information on self tests, test options, troubleshooting, and

service procedures, refer to the optional service guides available for the
system or the desired modules.

Saving and Reloading System Settings

The Save System Settings and Load System Settings fields are
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located under the Admain tab of the System Administration Tools
dialog. By saving your system settings to a flexible disk or a mounted
directory, you create a backup file that can be used to quickly setup
new systems, or restore a current system’s settings after a re-ignite
procedure (see page 46).

To save or reload your system settings, select the desired items, then
select Save to Flile, or Load Settings. If an item is not valid, or was not
initially saved to the file, the selection is greyed out in the interface.
Also, a .set file extension is automatically added for you.

Flexible Disk Backup - Re-ignite

Unless changed in the file browser, the flexible disk is the default drive when
saving a backup file. If you are going to re-ignite your logic analysis system,
you MUST save the settings to the flexible disk or a mounted directory. Files
saved on the analyzer’s hard disk will be lost during the re-ignite procedure
(see page 46).

What System Settings are Saved

e Printer Settings (see page 47)

e Network Settings (see page 47)

e User Account Information (see page 49)

e License Information (see page 50)

e (Custom Color Settings (see page 50)

e  Web Settings (see page 50)

e Session Manager (see page 50)

e E-mail on Trigger (see page 51)

Re-ignite Procedure

The re-ignite procedure is a process used to restore the operating
system to the hard disk. Since user configurations, data files, and
license passwords are lost during this procedure, it is recommended
that you save the system settings to a backup flexible disk or a
mounted directory.
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Printer Settings

Printer settings are located under the Printers... field on the Admin
tab of the System Administration Tools dialog.

e Printer Local or Network

® Network - Printer Name

e Network - Server Name

e s print server Berkeley UNIX - No/Yes
e Printer Type

Information in the Printer Queue, and any Print Options (see page 41) are not
saved.

Network Settings

Network settings are located on the Networking tab of the System
Administration Tools dialog.

Network Setup...

e Networking - Enable/Disable
e Hostname

e Internet Address (IP)

e (Gateway Name

e (Gateway IP

e Subnet Mask

e All Name Resolver... information
Map 95/NT Network Drive...

The following information is only saved if the Reconnect at Startup option is
enabled.

e Network Path
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e Logic Analyzer Dir Path
e Reconnect at Startup
e Read only

e All Current Connections information
Share Analyzer Drive...

The following information is only saved if the Reshare at Startup option is
enabled.

e Logic Analyzer Dir to Share

e Share Name

e Share Comment

e Reshare at Startup

o All Share Password information

e All Current Shares information
Mount NFS Filesystem...

The following information is only saved if Reconnect at Startup under the
Options... field is enabled.

* Remote Host

* Remote Dir Path

e Local Dir Path

e All NFS Options information

e All Current Connections information

Network Services

Even though Network Services is found under the Security tab of the
System Administration Tools dialog, the following settings are saved
under the Network settings selection.
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e  Web Server
e Shared Console (VNC)
e Remote Programming Interface

e penfsd (for PC NFS)

User Accounts

User Accounts settings are located on the Security tab of the System
Administration Tools dialog. In addition to the user account directory
structure, the following settings are saved:

If you save user accounts while you are in secure mode, after you load this
system settings file, you will be in secure mode. Because of this, it is very
important that you know a sys user and his password before loading a secure
saved user account file. Similarly, if you save user accounts while you are not
in secure mode, after you load the system settings file, you will not be in
secure mode.

User Accounts...

e Secure Mode - Disabled/Enabled

e All current accounts information

e User-specific custom colors

e User-specific Web bookmarks and Web preferences

It should be noted that no specific user account data is saved.

Network Services

Even though Network Services is found under the Security tab of the
System Administration Tools dialog, the following settings are saved
under the Network settings selection.

e  Web Server
e Shared Console (VNC)

e Remote Programming Interface
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e pcnfsd (for PC NFS)

Licenses

License information can only be saved and reloaded on the same logic
analysis system. If you are setting up new logic analysis systems using a
backup system settings file, all settings can be loaded except the
license information. However, if you are performing the re-ignite
procedure (see page 46) to the same logic analysis system, all settings
including the license information can be reloaded.

Custom Colors

The custom color settings saved are the system colors located in the
Waveform and Listing Tool’s menu bar Edit - Set default attributes....
In the Distribution and Chart tool, system colors are located under
Options - Color.

Custom colors for users in Secure Mode are saved and restored with
the User Accounts (see page 49) selection.
Web Settings

If you are using the logic analysis system in a stand-alone unsecured
mode, the following settings are saved.

e Bookmarks

e Preferences

Bookmarks and Preferences for users in Secure Mode are saved and
restored with the User Accounts (see page 49) selection.

Session Manager Settings

The following Session Manager settings are saved and restored with the
Network Setup (see page 47) selection.

e  Window size

e [Exclusive or Shared session
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E-mail on Trigger Settings

You configure the e-mail on trigger from within a Sequence level under
the Trigger Tab in the analyzer tool. The only setting that is saved is
the SMTP server name, and it is saved and restored with the Network
Setup (see page 47) selection.

NOTE:

Setting Up User Accounts

When you power up the instrument for the first time, you are in an
open-networked unsecured mode. Any user can access the logic
analysis system and store data with no record of access. By definition,
you are in the open-networked mode when Secure Mode is disabled.

User accounts are useful when large project teams share lab
equipment. In this environment, one or more users are set up with a
user account and given a login and password. User accounts add the
security of restricted use, plus the ability to trace all network activity
and file ownership. By definition, you are in the secured user accounts
mode when your System Administrator enables the Secure Mode field.

For more information on the user environment, refer to The User
Environment and Session Control (see page 86).

The default factory configuration is the open-networked unsecured
mode. Use the following procedures to set up user accounts and add
security to your system through the Secure Mode. You can set up user
accounts either individually, or by importing a file.

Any user can set up user accounts and become the system administrator the
first time the User Accounts dialog is accessed. To modify user account after
Secure Mode has been enabled, System Administration Privileges. (see
page 18) are required.

Adding User Accounts Individually

1. From the Security tab in the System Administration Tools window, click
User Accounts...

2. At the bottom on the window, click Add....
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3. From the Add-User Account dialog, type in the user’s Login Name.

r‘k

Type in the user’s Password (see page 53), and then the user’s Password
Again.

Optional — Type in the user's Encrypted Password,.
Optional - Type in a Password Age (see page 54).
Type in the User Identity and Group Identity.

Type in the user's Real Name.

© e N e O

Select the File Permissions (see page 88) field, and select the desired
system default read/write permissions.

10. Optional — Check Has Admin Privileges if you want to give the new user
System Administrator privileges.

11. Click Add. Repeat the above from step 3 for the next user account, or,
click Cancel to exit the dialog.

12. Toggle the Secure Mode field to Enabled. Enabling this field will activate
the use of user accounts and set the system to a secured team use
environment.

13. Click OK to close the User Accounts dialog.

14. At this point, you will be asked to verify the reboot of the logic analysis
system. A reboot is necessary to implement the system level change of the
secured user accounts mode.

Adding User Accounts by Importing a File

If you have multiple users that require user accounts, it might be easier
to simply import a password file. If you plan to import password files,
the files must follow the specified format for a password file. An
example of a password file with the specified format is located in "/
local_etc/" in the File Manager window.

You can use the example password file to generate your own file. Copy
the file to a word processor, edit the file, and then copy it back to the /
local_etc/ directory under a new name. For an example of copying files
to other systems, refer to FTP (file transfer protocol) (see page 34).

1. From the Security tab in the System Administration Tools window, click

52



Chapter 1: HP 16600A/16700A Series Logic Analysis System
The System Administration Tools

User Accounts...

2. Click Import.... Then from the Import Account Dialog that appears, select
the Default File Permissions (see page 88) field and set the desired system
default read/write permissions.

3. Click Import File. From the file browser that appears, select the file name
to import, and click OK.

4. From the Import Account dialog, click OK.

5. From the User Accounts dialog, edit the desired accounts giving at least
one user system administration privileges.

6. Toggle the Secure Mode field to Enabled. Enabling this field will activate
the use of user accounts and set the system to a secured team use
environment.

7. Click OK.

8. At this point, you will be asked to verify the reboot of the logic analysis
system. A reboot is necessary to implement the system level change of the
secured user accounts mode.

Enabling/Disabling User Accounts

Once you have a list of user accounts in the system, your System
Administrator can enable or disable user accounts by toggling the
Secure Mode field. When you change the working mode, you will be
asked to power down the system, and then power it back up. This
enables the network to identify the new working mode.

Editing the User Accounts List

To delete a user from the accounts list, click the desired User Account,
and click Delete.

To modify user information in the accounts list, click the desired User
Account, make the appropriate changes in the Account Information
dialog, and then click Modify.

Legal Passwords

e Passwords must be at least 6 characters long.
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e Passwords cannot be circular shift of your login ID.

e (Old and new passwords must differ by at least 3 positions.

Passwd Man Page

The following man page documents the use of a password file.

NAME
passwd - password file, pwd.h

DESCRIPTION
passwd contains the following information for each user:

login name

encrypted password

numerical user ID

numerical group ID

reserved field, which can be used for identification
initial working directory

program to use as shell

++ + + 4+

This is an ASCII file. Each field within each user’s entry is

separated from the next by a colon. Each user is separated from the
next by a newline. This file resides in the /etc directory. It can

and does have general read permission and can be used, for example,
map numerical user IDs to names. If the password field is null and

the system has not been converted to a trusted system, no password is

demanded.
If the shell field is null, /usr/bin/sh is used.

The encrypted password consists of 13 characters chosen from a 64-

character set of "digits" described below, except when the password is
null, in which case the encrypted password is also null. Login can be

prevented by entering in the password field a character that is not
part of the set of digits (such as *).

The characters used to represent "digits" are . for 0, / for 1, 0
through 9 for 2 through 11, A through Z for 12 through 37, and a
through z for 38 through 63.

PASSWORD AGE

Password aging is put in effect for a particular user if his encrypted

password in the password file is followed by a comma and a nonnull

string of characters from the above alphabet. (Such a string must be
introduced in the first instance by a superuser.) This string defines

the "age" needed to implement password aging.

The first character of the age, M, denotes the maximum number of weeks
for which a password is valid. A user who attempts to login after his

password has expired is forced to supply a new one. The next
character, m, denotes the minimum period in weeks that must expire

before the password can be changed. The remaining characters define

the week (counted from the beginning of 1970) when the password was
last changed (a null string is equivalent to zero). M and m have

numerical values in the range 0 through 63 that correspond to the 64-
character set of "digits" shown above. If m = M = 0 (derived from the
string . or ..), the user is forced to change his password next time

he logs in (and the "age" disappears from his entry in the password

file). If m > M (signified, for example, by the string ./), then only
a superuser (not the user) can change the password. Not allowing the

user to ever change the password is discouraged, especially on a
trusted system.

Trusted systems support password aging and password generation. For

more information on converting to trusted system and on password,
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the HP-UX System Administration Tasks Manual and sam(1M).

getpwent (3C) designates values to the fields in the following
structure declared in <pwd.h>:

struct passwd {
char *pw_name;
char *pw_passwd;
uid_t pw_uid;
gid t pw_gid;

char *pw_age;
char *pw_comment;
char *pw_gecos;
char *pw_dir;
char *pw_shell;
aid t pw_audid;
int pw_audflg;

}i

It is suggested that the range 0-99 not be used for user and group IDs
(pw_uid and pw gid in the above structure) so that IDs that might be
assigned for system software do not conflict.

The user’s full name, office location, extension, and home phone
stored in the pw gecos field of the passwd structure can be set by use
of the chfn command (see chfn(l)) and is used by the finger(1l)
command. These two commands assume the information in this field is
in the order listed above. A portion of the user’s real name can be
represented in the pw gecos field by an & character, which some
utilities (including finger) expand by substituting the login name for
it and shifting the first letter of the login name to uppercase.

SECURITY FEATURES

On trusted systems, the encrypted password for each user is stored in
the file /tcb/files/auth/c/user name (where c is the first letter in
user_name). Password information files are not accessible to the
public. The encrypted password can be longer than 13 characters

For example, the password file for user david is stored in
/tcb/files/auth/d/david. 1In addition to the password, the user
profile in /tcb/files/auth/c/user name also contains:

+ numerical audit ID
+ numerical audit flag

Like /etc/passwd, this file is an ASCII file. Fields within each
user’s entry are separated by colons. Refer to authcap(4) and
prpwd(4) for details. The passwords contained in /tcb/files/auth/c/*
take precedence over those contained in the encrypted password field
of /etc/passwd. User authentication is done using the encrypted
passwords in this file . The password aging mechanism described in
passwd(1l), under the section called SECURITY FEATURES, applies to this
password .

NETWORKING FEATURES

NFS
The passwd file can have entries that begin with a plus (+) or minus
(-) sign in the first column. Such lines are used to access the
Network Information System network database. A line beginning with a
plus (+) is used to incorporate entries from the Network Information
System. There are three styles of + entries:

+ Insert the entire contents of the Network Information
System password file at that point;

+name Insert the entry (if any) for name from the Network
Information System at that point

+@name Insert the entries for all members of the network
group name at that point.

If a + entry has a nonnull password, directory, gecos, or shell field,
they override what is contained in the Network Information System.
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The numerical user ID and group ID fields cannot be overridden.

The passwd file can also have lines beginning with a minus (-), which
disallow entries from the Network Information System. There are two
styles of - entries:

-name Disallow any subsequent entries (if any) for name.

-@name Disallow any subsequent entries for all members of
the network group name.

WARNINGS

User ID (uid) 17 is reserved for the Pascal Language operating system.
User ID (uid) 18 is reserved for the BASIC Language operating system.
These are operating systems for Series 300 and 400 computers that can
coexist with HP-UX on the same disk. Using these uids for other
purposes may inhibit file transfer and sharing.

The login shell for the root user (uid 0) must be /sbin/sh. Other
shells such as sh, ksh, and csh are all located under the /usr
directory which may not be mounted during earlier stages of the bootup
process. Changing the login shell of the root user to a value other
than /sbin/sh may result in a non-functional system.

The information kept in the pw_gecos field may conflict with
unsupported or future uses of this field. Use of the pw gecos field
for keeping user identification information has not been formalized
within any of the industry standards. The current use of this field
is derived from its use within the Berkeley Software Distribution.
Future standards may define this field for other purposes.
The following fields have character limitations as noted:

+ Login name field can be no longer than 8 characters;

+ Initial working directory field can be no longer than 63
characters;

+ Program field can be no longer than 44 characters.

+ Results are unpredictable if these fields are longer than the
limits specified above.

The following fields have numerical limitations as noted:

+ The user ID is an integer value between -2 and UID MAX
inclusive.

+ The group ID is an integer value between 0 and UID MAX
inclusive.

+ If either of these values are out of range, the getpwent (3C)
functions reset the ID value to (UID_MAX).

EXAMPLES

NFS Example

Here is a sample /etc/passwd file:

root:3Km/04Cyqg84Xc:0:10:System Administrator:/:/sbin/sh
joe:r4hRJr4GJ4CqgE:100:50:Joe User,Post

4A,12345: /home/joe: /usr/bin/ksh

+john:

-bob:

+@documentation:no-login:

-@marketing:

+:::Guest

In this example, there are specific entries for users root and joe, in
case the Network Information System are out of order.

+ User john’s password entry in the Network Information System
is incorporated without change.
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+ Any subsequent entries for user bob are ignored.

+ The password field for anyone in the netgroup documentation
is disabled.

+ Users in netgroup marketing are not returned by getpwent (3C)
and thus are not allowed to log in.

+ Anyone else can log in with their usual password, shell, and
home directory, but with a pw gecos field of Guest.

NFS Warnings
The plus (+) and minus (-) features are NFS functionality; therefore,
if NFS is not installed, they do not work. Also, these features work
only with /etc/passwd, but not with a system that has been converted
to a trusted system. When the system has been converted to a trusted
system, the encrypted passwords can be accessed only from the
protected password database, /tcb/files/auth/*/*. Any user entry in
the Network Information System database also must have an entry in the
protected password database.

The uid of -2 is reserved for remote root access by means of NFS. The
pw_name usually given to this uid is nobody. Since uids are stored as
signed values, the following define is included in <pwd.h> to match
the user nobody.

UID_NOBODY (-2)
FILES
/tcb/files/auth/*/* Protected password database used when
system is converted to trusted system.
/etc/passwd Standard password file used by HP-UX.
SEE ALSO

chfn (1), finger(l), login(1l), passwd(l), a641(3C), crypt(3C),
getprpwent (3), getpwent(3C), authcap(4), limits(5).

STANDARDS CONFORMANCE
passwd: SVID2, SVID3, XPG2

Change Password

You do not require system administration privileges to change your

password.

1. From the Security tab in the System Administration Tools window, click
Change Password...

2. If your account previously had a password, you will enter it in the Old
Password field.

3. Enter your new password (see page 53) in the New Password field.

4. Enter it again in the New Password Again field.

5. Click OK.
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Web Server Security

Use this selection to allow or prevent access to the web page of this
logic analysis system from other workstations or personal computers.

e Select On if you wish to allow other workstations and personal computers
to access the home page of this logic analysis system.

e Select Off to prevent other workstations and personal computers from
accessing the home page of this logic analysis system.

NOTE:

Shared Console (VNC) Security

Use this selection to allow or prevent sharing of the graphical user
interface by remote workstations or personal computers.

e Select On if you wish to allow the graphical user interface to be shared
with remote workstations or personal computers.

e Select Off if you wish to prevent sharing of the graphical user interface by
other workstations and personal computers.

To prevent a current shared session from being terminated, changes to the
VNC Security (turning off) will take effect after the current session is closed.

Remote Programming Interface Security

Use this selection to allow or prevent connection to the remote
programming port (Port 6500) by other workstations or personal
computers connected on the same LAN.

e Select On if you wish to accept remote programming connections from
other workstations and personal computers to the remote programming
port of this logic analysis system.

e Select Off if you wish to reject all remote programming connections to the
remote programming port of this logic analysis system.
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pcenfsd (For PC NFS) Security

Use this selection to allow access and operation of the logic analysis
system by PC NF'S file system packages that require pcnfsd
capabilities.

e Select On if you are using a PC NF'S file system package to operate the
logic analysis system, and your package requires pcnfsd capabilities in the
logic analysis system.

e Select Off if you are not using a PC NF'S file system package that requires
pcnfsd capabilities in the logic analysis system.

See Also

Install Software

1. From the Software Install tab in the System Administration Tools window,
select Install....

2. In the Software Install dialog that appears, select the media type Flile
System.

3. If you are loading software from a Hard Disk and NF'S, type in the path to
the files you are installing, or use the graphical Browse. Make sure the
remote file system is mounted.

4. Click Apply.

5. From the list of files that appear, click the desired file, and then click
Install....

List all Installed Software (see page 60)
Remove Software Files (see page 59)

Configuring the NF'S (see page 30)

Remove Installed Software

1. From the Software Install tab in the System Administration Tools window,
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select Remove....

2. From the Software Remove dialog, select the file to remove, and click
Remove....

3. Click Continue to remove the selected file.

Install Software (see page 59)

List all Installed Software (see page 60)

See Also

List Installed Software

Use the Software List... field to view all system files currently installed
on the hard disk. In addition, specific file information such as file size
or version is shown. To get detailed information on any specific file,
select the file, and click the Details... field.

To list installed software, access the System Administration Tools
window, click the Software Install tab, and then click the List...
button.

Install Software (see page 59)

Remove Software Files (see page 59)
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The User Interface - Icons, Tabs, and Navigation

The graphical user interface is designed to help you configure
measurements and quickly navigate between windows.

The System Window

The System window (see page 102) visually displays the personality
of your logic analysis system. It graphically shows which measurement
modules are installed and what run control capability is available.

The System window is used as a home base for making measurements.
By clicking a measurement module icon, you not only gain access to all
instrument Setup windows, but you automatically connect Display
tools to the Instrument tool in the Workspace window.

Tabs

The use of Tabs (see page 103) throughout the interface helps you
quickly navigate between tool setup windows, and other functional
areas within tool windows.

The Icon Bar

A system Icon Bar (see page 104) is located in the System window to
allow you quick access to these functional areas:

Workspace (see page 14)
Intermodule (see page 12)

System Administration (see page 16)
File Manager (see page 63)

The Setup Assistant (see the Setup Assistant help volume)

The Window Manager

When you view the logic analysis system locally, it makes a window
manager available that places all minimized windows at the bottom of
the display in a task bar.
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If you telnet into the logic analysis system remotely, you do not see the
window manager. Because you are viewing the instrument from your
remote computer, you are using the remote machine’s window
manager.
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File Management Tools

&

Use the File Manager window to perform the common tasks of loading
or saving measurement configurations. The File Manager has all the
standard functionality for performing operations on files and
directories on both the flexible and hard disk drives.

e “Make a Directory” on page 64
e “Delete a Directory” on page 64

e “Rename a Directory” on page 65

e  “Autoloading a File” on page 64

e “Loading Configuration Files” on page 81
e “Saving Configuration Files” on page 83
e “Copy a File” on page 65

e “Delete a File” on page 66

e “Move a File” on page 66

e “Rename a File” on page 66

e  “Compressing Files - PKZIP” on page 67

e “Format a Floppy Disk” on page 69
e “Refresh the File Manager” on page 69

e “Mounting an External Hard Drive” on page 70
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See Also

“File Types” on page 78

“Default Directory Descriptions” on page 68

Autoloading a File

The following procedure designates a file to automatically load at
session startup.

1.

From the menu bar in the File Manager window, click Options, then
Autoload....

From the Autoload File dialog that appears, click the Enable Autoload
field, then select the directory and filename you want loaded at startup.

Select OK.

Make a Directory

1.

From the File Manager dialog, set the Current Disk: to the desired disk
drive.

If necessary, double-click directory names to build a path to the level
where you want the new directory.

Select the Create Directory tab.

Type the new directory name. Directory names can only include the
following alphanumeric characters:

0'97 a-z, A'Z> (')a (+)> (—)7 ()a and ()
Click Create Directory.

To close the File Manager dialog, click Close.

Delete a Directory

1.

From the File Manager dialog, set the Current Disk: to the desired disk
drive.
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If necessary, double-click directory names to build a path to the directory
you want to delete.

Select the directory to delete, then select the Delete tab.
Click Delete, then Yes to verify.

To close the File Manager dialog, click Close.

Rename a Directory

1. From the File Manager dialog, set the Current Disk: to the desired disk
drive.

2. If necessary, double-click directory names to build a path to the directory
you want to rename.

3. Select the directory to rename, then select the Rename tab.

4. Type in the new name, then click Rename. Directory names can only
include the following alphanumeric characters:

0'97 a-z, A'Z> (')a (+)> (—)7 ()a and ()

5. To close the File Manager dialog, click Close.

Copy a File

1. From the File Manager dialog, select the file you want to copy.

2. If necessary, set the Current Disk, and double-click directory names to
build a path to the file you want to copy.

3. Select the Copy tab.

4. Select a Destination: for the file you are copying. Do this by either
selecting the desired disk drive and typing a path and filename, or,
Browse... a graphical file list to select a path and filename. You can also
quickly copy the same path as the source file.

5. Click Copy.

6. To close the File Manager dialog, click Close.
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Delete a File

1. From the File Manager dialog, set the Current Disk: to the appropriate
disk drive.

2. Select the file to delete. If necessary, double-click directory names to build
a path to the file you want to delete.

Select the Delete tab.
Click Delete.

Click Yes to verify.

S

To close the File Manager dialog, click Close.

Move a File

1. From the File Manager dialog, select the file you want to move.

2. If necessary, set the Current Disk, and double-click directory names to
build a path to the file you want to move.

3. Select the Move tab.

4. Select a Destination: for the file you are moving. Do this by either
selecting the desired disk drive and typing a path and filename, or,
Browse... a graphical file list to select a path and filename. You can also
quickly copy the same path as the source file.

5. Click Move.

6. To close the File Manager dialog, click Close.

Rename a File

1. From the File Manager dialog, set the Current Disk: to the desired disk
drive.

2. If necessary, double-click directory names to build a path to the directory
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you want to rename.
3. Select the file to rename, then select the Rename tab.

4. Type in the new name, then click Rename. Filenames can only include the
following alphanumeric characters:

0-9, a-z, A-Z, (-), (+), (), (), and ().

5. To close the File Manager dialog, click Close.

About File Extensions

When saving configuration files, file extensions (characters following a
""in the filename) will be ignored by the system. Instead, default file
extensions (see page 78) are automatically appended. When saving
data files from the File Out (see the File Out Tool help volume) tool,
you can use file extensions. You can list all files by using a single
asterisk (*) after the directory path.

Compressing Files - PKZIP

This operation compresses files. Use this operation prior to copying
files to floppy disk for purpose of transfer.

To Compress a File - PKZIP

1. From the File Manager dialog, double-click directory names to build a path
to the file you want to compress.

2. Click the file name you want to compress.
3. From the menu bar select Compress, then PkZip.

4. Typein a new (compressed) file name, then click OK. You can only use the
following alphanumeric characters in a filename:
0'97 a-z, A'27 (')a (+)> (—)7 ()a and ()

5. To close the File Manager dialog, click F'ile in the menu bar, then select
Close.

To Uncompress a File - PKUNZIP

1. From the File Manager dialog, double-click directory names to build a path
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to the file you want to uncompress.
2. Click on the desired file you want to uncompress.
3. From the menu bar select Compress, then PKunzip.

4. To close the File Manager dialog, click Fzle in the menu bar, then select
Close.

“More About PKZIP” on page 68

More About PKZIP

ASCENT SOLUTIONS, Inc. (ASi) provides compatible, open systems
data compression solutions such as PKZIP, Multizip, and WinZip. ASI
solutions are 100% cross-platform compatible, and support a variety of
platforms, including Unix, MVS, AS/400, VM, VSE, VMS, Windows,
Netware, Macintosh, DOS, and OS/2. Data compression options are
available in both stand-alone and developer’s versions.

ASCENT SOLUTIONS, Inc. (ASi)
9009 Springsboro Pike
Miamisburg, OH 45342

Contact:

Voice: (937) 847-2374
FAX: (937) 847-2375
Email: info@asizip.com

Default Directory Descriptions

configs/

This directory is used to store user workspace configuration and data
files.

etc/

This directory is for internal use only.
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ia/
This directory is used to store inverse assembly files. It is read only and

can only be modified through the installation and remove process for
processor support packages.

log/

Error log files generated by system crashes and errors are
automatically saved to this directory. Error log files, along with saved
configuration files, can be used to recreate and fix system error
conditions.

omfs/

This directory is used to store Object Management Files (OMF) or
executable files that are used by the built-in symbol utility.

demo/

This directory is used to store product demonstration files. Several
processor trace files use IA files stored in the za directory. This
directory and its files may be deleted if disk space is required.

Format a Floppy Disk

This operation formats new floppy disks in DOS format.
1. Insert the new floppy disk into the disk drive of the logic analysis system.

2. From the menu bar in the File Manager dialog, select Disk, then click
Format.

3. To close the File Manager dialog, click F%le in the menu bar, then select
Close.

Refresh the File Manager

If you add, delete, or rename a file while the File Manager window is

69



Chapter 1: HP 16600A/16700A Series Logic Analysis System
File Management Tools

open, the directory you are in will not show the latest changes until you
refresh the directory by selecting Disk, then Refresh Current
Divectory.

CAUTION:

Mounting an External Hard Drive

The following installation guidelines show the important sequence of
steps when connecting or disconnecting the external hard drive. For
the complete procedure, refer to the "Logic Analysis Systems
Installation Guide".

Connecting the External Hard Drive

It is very important to follow the sequence of steps exactly when connecting
or disconnecting the external hard drive. The external hard drive should be
the first device that receives power, and the last device to be shut down. If you
do not follow the correct sequence of steps, data on the external hard drive
may become corrupt or the drive may become unreadable.

1. Power down the logic analysis system frame.
Connect the external hard drive.
Power up the external hard drive.

Power up the logic analysis system frame.

ook o

From the interface, mount the external hard drive. See the procedure
Mounting the External Hard Drive below.

Disconnecting the External Hard Drive

The following guidelines must be followed before removing the
external hard drive from its case, or disconnecting the drive from the
logic analysis system.

1. From the interface, unmount the external hard drive. See the procedure
Unmounting the External Hard Drive below.

2. Power down the logic analysis system frame.

3. Power down the external hard drive.
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Disconnect the external hard drive.

Mounting the External Hard Drive

If this is the first time mounting the external hard drive, or if the drive is
corrupt, you will get a message asking if you want to format the disk. If you
choose to format the drive, all data on that drive will be lost.

1.

From the Icon bar in the main system window, select the System Admin
icon, then from the System Administration Tools window that appears,
select the Admin tab.

From the System Administration Tools window select Mount External
Disk....

In the Mount External Disk dialog, set a SCSI Address number. Select the
same number that is displayed in the green LCD on the front panel of the
external hard drive.

In the Local Path: field, type in the local directory name where the drive
will be mounted. This should be either an existing empty directory, or, one
that does not yet exist. If it does not exist, it will be created automatically
for you.

Select Mount to mount the drive. The drive is now accessible through this
directory.

Unmounting the External Hard Drive

1.

From the Icon bar in the main system window, select the System Admin
icon, then from the System Administration Tools window that appears,
select the Admin tab.

From the System Administration Tools window select Mount External
Disk....

In the Mount External Disk dialog, select the drive from the Current
Conmnections list, then select Unmowunt. This will not affect the files on the
drive. They will just not be accessible until the drive is mounted again.
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Product Description

The HP 16600A-Series and HP 16700A-Series logic analysis systems
are a scalable family of frames that allow you to time-correlate
measurements across domains from analog signals to source code.
Both new frames support most measurement solutions of the HP 16500
frame as well as future analysis modules and microprocessor solutions.

Included in both the HP 16600A and HP 16700A-Series frames is an
integrated Web server and Home Page. Use the Home Page as the
starting point to upload PC connectivity software that enables remote
front-panel control and post-processing within an Excel spreadsheet.

The graphical user interface provides easier measurement setup and
product use. For microprocessor measurements, a Setup Assistant
leads you through the setup process.

The HP 16700A-Series

The HP 16700A-Series logic analysis system frame has five slots for
measurement modules, and two dedicated emulation module slots.

The HP 16600A-Series

The HP 16600A-Series logic analysis system frames offer a more
focused solution. The HP 16600A-series frames include an embedded
logic analyzer acquisition module with a channel width of 68, 102, 136
or 204 channels, depending on the model. State clock speed is up to
100 MHz, and full-channel timing speed is up to 125 MHz. In half-
channel acquisition mode, timing speed is up to 250 MHz.

One modular slot is available for integration of an oscilloscope, pattern
generator, or another logic analyzer. Also included in the frame is one
dedicated slot for an emulation module.
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Master List of All Tool Help Volumes

All Instrument, Display, Utility, and Analysis tools, have their own
specific help volume. The Help menu within each tool window accesses
its own help volume. You can access specific Tool Help Volumes below,
or, you can return to the Main Help Volume. (see page 2)

See Also: Online Help Information on the World Wide Web (see
page 91)

The Instrument Tools

HP 16600-Series Built-In Logic Analyzer (see the HP 16600A-Series 100
MHz State/250 MHz Timang Logic Analyzer help volume)

HP 16517A High Speed Timing Analyzer (see the HP 16517A 4GHz
Timang/1GHz State Logic Analyzer help volume)

HP 16522A Pattern Generator (see the HP 16522A 200 MHz Pattern
Generator help volume)

HP 16533/34A Oscilloscopes (see the HP 16533/34A Digitizing
Osctlloscope help volume)

HP 16550A Logic Analyzer (see the HP 16550A Logic Analyzer help
volume)

HP 16554A Logic Analyzer (see the HP 16554A .5M Sample Logic
Analyzer help volume)

HP 165655A/D Logic Analyzer (see the HP 16555A/D 110MHz State/500
MHz Timing Logic Analyzer help volume)

HP 16556A/D Logic Analyzer (see the HP 16556A/D 100 MHz State/400
MHz Timing Logic Analyzer help volume)

HP 16557D Logic Analyzer (see the HP 16557D 140 MHz State/500 MHz
Timang Logic Analyzer help volume)

HP 16710A Logic Analyzer (see the HP 16710 8K sample Logic Analyzer
help volume)

HP 16711A Logic Analyzer (see the HP 16711 32K sample Logic
Analyzer help volume)
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e HP 16712A Logic Analyzer (see the HP 16712 128K sample Logic
Analyzer help volume)

e HP 16715A Logic Analyzer (see the HP 16715A 167 MHz State/667 MHz
Timing Logic Analyzer help volume)

e HP 16716A Logic Analyzer (see the HP 16716A 167 MHz State/2 GHz
Timang Zoom Logic Analyzer help volume)

e HP 16717A Logic Analyzer (see the HP 16717A 333 MHz State/2 GHz
Timing Zoom Logic Analyzer help volume)

e HP 16718A Logic Analyzer (see the HP 16718A 333 MHz State/2 GHz
Timing Zoom Logic Analyzer help volume)

e HP 16719A Logic Analyzer (see the HP 16719A 333 MHz State/2 GHz
Timang Zoom Logic Analyzer help volume)

See Also: Using Symbols (see page 152)

The Display Tools

e Listing Display (see the Listing Display Tool help volume)

e  Waveform Display (see the Waveform Display Tool help volume)

e Chart Display (see the Chart Display Tool help volume)

e Distribution Display (see the Distribution Display Tool help volume)

See Also: Using Markers in the Display Tools (see the Markers help
volume)

The Analysis Tools
e Pattern Filter Analysis (see the Pattern Filter Tool help volume)

e  (Compare Tool (see the Compare Tool help volume)

Add-on Toolsets
e DataComm Analysis (see the DataComm Analysis Toolset help volume)

e System Performance Analysis - SPA (see the System Performance
Analyzer help volume)

e Source Viewer (see the Listing Display Tool help volume)
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e Serial Analysis (see the Serial Analysis Tool help volume)

e  Memory Expansion Interface (see the HP E2485A Memory Expansion
Interface help volume)

If an add-on tool is not installed, you will see a message stating that the help
volume could not be found. If you wish to purchase any of these add-on
toolsets, call your local Hewlett Packard sales representative.

The Utility Tools
e File In Tool (see the File In Tool help volume)
e File Out Tool (see the File Out Tool help volume)

The Emulation Control Interface Tools

Help for each processor-specific emulation control interface is installed with
the processor support package for the processor. If support for a processor is
not installed, you will see a message stating that the help volume could not be
found. Additional processors may be supported. To see help for processors not
listed here, start an Emulation Control Interface session then click Help.

e Setting Up and Starting Emulation Control (see the Emulation: Setting
Up help volume)

e Emulation - ARM7 (see the Emulation: ARM7 help volume)
e Emulation - M-CORE (see the Emulation: M-CORE help volume)

e Emulation - MPC8xx Embedded PowerPC (see the Emulation: PowerPC
8xx help volume)

e  Emulation - MPC82xx (see the Emulation: MPC82xx help volume)
e Emulation - M683xx (see the Emulation: Motorola 683xx help volume)

e Emulation - Pentium (see the Emulation: Pentium and Pentium w/
MMX Technology help volume)

e Emulation - Pentium Pro (see the Emulation: Pentium Pro and
Pentium II Processor family help volume)
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e Emulation - PowerPC 4xx (see the Emulation: PowerPC 4xx help
volume)

e  Emulation - PowerPC 500 (see the Emulation: PowerPC 5xx help
volume)

e  Emulation - PowerPC 60x (see the Emulation: PowerPC 603/604 help
volume)

e Emulation - PowerPC 7xx (see the Emulation: PowerPC 7xx help
volume)

e  Emulation - SH7750 (see the Emulation: Hitachi SH7750 help volume)
e Emulation - TX19/39 (see the Emulation: Toshiba TX19/39 help volume)

PC Connectivity

e HP 16700 Series Connectivity (see the PC Connectivity help volume) -
The Home Page and Remote Front Panel Control
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Overview - Starting a New Measurement

This overview shows how the graphical interface is used to configure
the logic analysis system for simple measurements.

1.
2.

5.

Connect the appropriate probing (see page 144) to your target system.

From the System window, (see page 106) click the desired Instrument tool
icon, then select Setup. If you are configuring a multi-instrument
measurement, click on all desired Instrument tool icons.

When you click on a tool icon and select Setup, two things occur. First,
a set of tabbed setup windows for the selected Instrument tool appear.
Next, the commonly required Display tools are automatically
connected to the Instrument tool in the Workspace window. (see

page 14)

From the Setup windows that appear, configure the appropriate
parameters for the measurement you are performing.

For example, a logic analyzer will require specific pod, clock, and
channel assignments. Also, a trigger specification is required if you
want the measurement to start at a specific point in the execution of
the target system. See "Setting up Instrument Tools"below.

Click the Instrument tool icon and select the desired Display tool. (see
page 107) The Display tool will show the captured data set. In addition to
viewing captured data, use Display tools to place markers in the data, or to
connect a multi-instrument configuration.

From any open window, click Run All.

Setting up Instrument Tools

Depending on the Instrument tool used and the type of measurement
being made, the setup varies. For more specific information on
configuring Instrument tools, refer to the following list of tools (see
page 73).

n
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Loading & Saving Configuration Files
Trace data and the settings you have made in system tools can be saved
to hard or floppy disk in configuration files.

The Load Configuration and Save Configuration windows can be
accessed:

e From the File Manager, navigate to the desired file, select it, and press
Load or Save.

e From any tool, select File->Load Configuration or File->Save
Configuration

® You can save the system settings along with the current data (Save Config
and Data) or just save the settings (Save Config Only).

e You can save settings and data for all configured tools (instruments,
analysis and display tools) or just an instrument.

You can load settings/data for all tools configured at the time of saving, or
just the instrument.

e Data saved in a config file is always loaded.
e “File Types” on page 78
e  “What Gets Loaded” on page 79

Loading Configuration Files (see page 81)

e Saving Configuration Files (see page 83)

File Types

When saving tool configurations, one or more files will be created in the
destination file system. For example:

test_setup. A 16601 LA Config
test_setup. System Config
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A file for each instrument tool involved in the Save process will be
created. An additional file may be created to store additional system
information.

e The same file name prefix is used for all of the files. (The name you
specified)

e The file suffix indicates the card slot of the instrument whose parameters
were saved, or 3 underscores for system information.

e The file type indicates the type of data contained in the file.

e “What Gets Loaded” on page 79
e  “Other File Types” on page 80

What Gets Loaded

When loading a config file, the destination selector determines which of
the files will be loaded into actual instruments. You only need to
highlight one of the files created in a given Save, and the system
software will load the correct data.

Given these files:

test_setup. A 16601 LA Config
test_setup. System Config

If the above file test _setup. Ais highlighted, and All is selected
as the destination, the information in file test setup. is also
loaded.

If the file test_setup._ _Ais highlighted, and a specific analyzer is
selected as the destination, only the analyzer data is loaded, no related
system information.

Selecting All as the destination will deactivate the selections for Load
Config and Tools and Load Config Only. When All is not selected, you
have these options:

e Load Config and Tools - Load into the selected instrument and all of the
tools connected to it at the time of saving.
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e Load Config Only - Load into the selected instrument, but not into any
tools that were connected at the time of saving.

Other File Types

e x - Typically an OMF or executable file. These files are used by the symbol
utility.

e ns - Output of the symbol utility when linked to a label. These files are
used by the symbol utility.

® pcx - Formatted bit map file.

tif - Tagged Image File Format.

e eps - Extended Postscript file.

.txt - Output of the File Out tool. This is an ASCII data file.
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Loading Configuration Files

Load a configuration file by selecting File->Load Configuration in a
tool window, or by clicking the Load tab in the File Manager.

1.

From the File Manager window, select a file to load in the Contents frame
of the dialog. You may need to navigate the local or mounted file system
using the Current Disk field and the Directories frame to find the desired
file. (Optionally, type the desired filepath and name in the "Filename"
box.) Note that a mounted directory will have a different icon.

Choose a target (see page 82) that defines where the config will be loaded.
e All will load all tools configured at the time of saving,.

e Selecting a specific instrument will narrow the loading to just that
instrument.

If loading into a specific instrument, choose:

e Load Config and Tools - loads the selected instrument and all tools
connected to its output.

e  Load Config Only - loads only the selected instrument.

Click Load.

File Manager
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Loading a configuration file will overwrite the settings and data in the
existing tools. This dialog will appear asking you to verify the loading of
new data:

Loading config will overwrite the configurations
of all machines and diszplays from 16550A {Slot O
Do you really want to do this?

More About Configuration Files (see page 78)

Saving Configuration Files (see page 83)

Target for the Load File Operation

Only the chosen Target will have the load operation performed on it.

e All — All Instrument tools on the Workspace. This selection loads a
complete System Configuration file.

e Instrument — Only the selected Instrument tool. This selection is used
when you are only interested in loading a file into a particular instrument.

82



Chapter 1: HP 16600A/16700A Series Logic Analysis System
Saving Configuration Files

Saving Configuration Files
Save a configuration file by selecting File->Save Configuration in a
tool window, or by clicking the Save tab in the File Manager.

1. From the File Manager window, in the Directories: frame, build a path to
the directory where you want to save the config file.

2. Type the name of the new config file, or select an existing file in the
Contents: frame for overwriting.

3. Select:

e Save Config and Data - saves settings and the current contents of
acquisition memory.

e  Save Config Only - saves only the current tool settings.
4. Select a source: (see page 84)
e Al - Saves settings for all currently configured tools.
e A specific instrument - only saves settings for the selected instrument.

5. Optionally, enter a description of the config which will appear in the File
Manager Contents: frame. (32 chars max)

6. Click Save.
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File Manager

See Also More About Configuration Files (see page 78)
Loading Configuration Files (see page 81)
Source for the Save File Operation (see page 84)
Config and Data/Config Only Option (see page 85)
File Out Tool (see the Fiile Out Tool help volume)

Source for the Save File Operation

Only the chosen Source will have the save operation performed on it.

e All — All Instrument tools on the Workspace. This selection saves a
complete System Configuration file.

e Instrument — Only the selected Instrument tool. This selection is used
when you are only interested in saving a file for a particular instrument.
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Config and Data/Config Only Option

Configuration and Data

This option saves the instrument setup configuration and the data
stored in acquisition memory. This file option generates the largest file
size.

Configuration Only

This option saves just the instrument setup configuration. When
reloaded, you must run the measurement again to acquire data. This
option generates a smaller file size thus a faster file operation time.
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The User Environment and Session Control

This overview describes the user environment of the logic analysis
system. Specifically, it defines the difference between how the typical
user interacts with the product compared to the system
admanistrator. You also get a description of the two working use
models: an "open-networked" system, and a "Secure Mode"
environment where user accounts and passwords are assigned.

For the most part, the differences encountered while working in either
use model occur during initial product configuration, or when you first
start a measurement session. In addition, if the secured environment of
Secure Mode is not enabled, there is no distinction between typical
users and a System Administrator.

For more information on using the security of user accounts and its
effects on the user environment, refer to Setting Up User Accounts
(see page 51).

Ordinary Users vs System Administrator

If Secure Mode is enabled, the typical user can only perform the
following system-level tasks:

e (Change your own password.
e NFS-mount file systems to the instrument.
e Telnet and FTP to other networked systems.

If Secure Mode is enabled, only the System Administrator can perform
the following system-level tasks:

e (Configure the network.
e [Enable the use of User Accounts.
e Add and remove individual User Accounts.

e Set the system-wide default file permissions (see page 88). Defaults at
initial power-up are -rw—r—r— for files and —rwxr—-xr—x for directories.

e Set user permissions for new file creation.
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e Set the system time.

e Set NF'S export permissions from the instrument.

Identifying your System Administrator

Your System Administrator is the first person who accesses the User
Accounts dialog and assigns himself system administration privileges.
From that point forward, the User Accounts... pick is unavailable for all
users except the identified System Administrators. At the time a user
logs in, the system software checks for system administration
privileges and sets the appropriate access mask on the User
Accounts... dialog as well as other restricted areas of the system.

For more information on System Administrator Privileges, refer to
System Administration Privileges (see page 18).

Use Models - Open-Networked Compared to User Accounts

When you power up the instrument for the first time, you are in an
open-networked unsecured mode. Any user can access the instrument
and stored data with no record of access. By definition, you are in the
open-networked mode when Secure Mode is not enabled.

The User Accounts mode is often used where large project teams
share lab equipment. In this environment, one or more users are set up
with a user account and given a login and password. User accounts add
the security of restricted use, plus the ability to trace all network
activity and file ownership. By definition, you are in User Accounts
mode when your System Administrator enables the Secure Mode.

Switching between Open Network and User Accounts

Your System Administrator can switch between the open networked
mode and the secured User Accounts mode at any time.

1. From the System Administration Tools window, click User Accounts....
Toggle the Secure Mode field to either Enabled or Disabled.
Click OK.

> 0 o

At this point, you will be asked to verify the reboot of the logic analysis
system. A reboot is necessary to implement the system level change of the
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secured user accounts mode.

See Also

For more information on the Session Control windows used in starting
a session, refer to Starting a Session (see page 89).

For more information on setting up the network, user accounts, and
other system tasks, refer to System Administration Tools (see
page 16).

About File Permissions

The System Default File Permissions specify a default value for
accounts created either during the import process or during Add.

File permissions specify read/write access at three different levels. This
maps directly to the UNIX(tm) definitions of user, group, and world
access: the first two characters define permissions of the user, the
second two are for groups, and the last two are for anyone, regardless
of user or group identity.

I'W——m

The most restrictive permissions. No one other than the creator of the
file is allowed to read or write it.

ITWI—

Users who belong to the same group (the GID field in the account
dialog) will be able to read the user's files, but cannot write to them.

TWIw—
The group can both read and write this user's files.
TWr——
All users can read these files, but only the creator can write to them.
TWIWI—

All users can read these files, and the group can both read and write to
them.
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TWI'WI'W

All users can read and write all files owned by this user.

Starting a Session

The Session Manager dialog is used to start a new exclusive session,
start a shared session, or, if another user has already started a shared
session, you can select to join the current shared session.

Session Startup

Exclusive session - Use this selection to start a session on the logic
analysis system local display (Console), or, if you have telneted to the
logic analysis system from a remote computer (RemoteX). With this
type of session, you are the only user allowed access to the session.

Shared session - Use this selection to start a shared session on the
logic analysis system. With this type of session, you are allowing other
users to connect and share the front panel.

If the Shared session selection has changed to Jown the current
shared, session, this indicates that a remote user has already started a
shared session. Select Join the current shared session to join the
session and display the analyzer on the local display.

Start Session

Select Start Session to display the logic analysis system main window
from the session startup mode chosen in Sesston Startup described
above.

Shutdown
Select Shutdown to terminate the current session.

Powerdown - This is a complete shutdown, and is used prior to turning
the power off.

Restart - This is a reboot to a new session.
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Close (Remote sessions only)

If you have a remote session running, a Close button is available. This
terminates your remote session leaving the logic analysis system
available for a new session.

Data and configurations ARE NOT restored after an Exit, a Shutdown, or
remote session Close. Make sure to save your configuration.
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Available Help Resources

The HP 16600/16700 Configuration Guide is a booklet which explains how
to set up your Logic Analysis System.

Making Basic Measurements is a tutorial booklet which guides you through
the user interface and basic system tools.

The Online Help System is a group of task-oriented help volumes that are
displayed in a window on your screen. Online help is accessed from a
pulldown menu in each system tool or from a "Help" button in many system
dialogs.

e Using the Online Help System (see the Help On Help help volume)
e Searching for information (see the Help On Help help volume)

Online Help information is also available on the World Wide Web (see
page 91).

A volume of Measurement Examples (see the Measurement Examples
help volume) will guide you in performing meaningful measurements with
your system. Many common data measurements are described, with
instructions for setting up the analyzer.

Glossary of System Terms (see page 179)

Logic Analyzer Terminology (see page 108)

Information on the Web

Enter the following URL:

http://www.agilent.com/find/logicanalyzer-manuals

This page contains logic analyzer microprocessor debug and emulation
solution manuals and online help. To access the HTML version of this
online help:

1. Click "Logic Analyzer Manuals and Online Help".

. In the next page, under the heading, "HP 16600A/16700A-Series Logic
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Analysis System," click "HP 16600A/16700A-Series Logic Analysis System
Help".

3. In the page that appears, click "HP 1600A/16700A Logic Analysis System
Help".

You will see the top page of this online help.
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System Overview

e Product Description (see page 72)

e The User Interface - Icons, Tabs, and Navigation (see page 61)
e Session Control and the User Environment (see page 86)

e “Frame Specifications and Characteristics” on page 93

e  “How the Help System is Organized” on page 95
List of Tool Help Volumes (see page 73)

For information on product Warranty and Safety Considerations, refer to the
hardcopy Installation Guide.

NOTE:

Frame Specifications and Characteristics

The characteristics listed below apply to the 16600A-series frame and
the HP 16700A-series frame. For specification or characteristic
information on specific measurement cards that install into the frames,
refer to the specific tool help volumes (see page 73) for each tool. For
specification or characteristic information on the 16600A-Series built-
in logic analyzer, click the following;:

e 16600A-Series Built-In Logic Analyzer Specifications (see the HP 16600A-
Series 100 MHz State/250 MHz Timing Logic Analyzer help volume)

e 16600A-Series Built-In Logic Analyzer Characteristics (see the HP
16600A-Series 100 MHz State/250 MHz Timing Logic Analyzer help
volume)

Definition of Terms To understand the difference between specifications (see
page 94) and characteristics (see page 94), and what gets a calibration
procedure (see page 95) and what gets a function test (see page 95), click the
appropriate links within this note.
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Power Requirements
~Line 115 V / 230 V
48 - 66 Hz
285 W (16600A-series frames)
610 W (16700A-series frames, except 16701A)
545 W (16701A frame)
CAT II; POLLUTION DEGREE 2

Operating Environment Characteristics
- Indoor use only.
- Temperature
Instrument (except disk and media): 0 to 50 degrees C (+32
to 122 degrees F)

Disk and media: 10 to 40 degrees C (+50 to
104 degrees F)
Probe lead sets and cables: 0 to 65 degrees C (+32 to

149 degrees F)
- Humidity
Instrument, probe lead sets, and cables: 8 to 80% relative humidity at
40 degrees C (+104 degrees F)

- Altitude To 3000 m (10,000 ft)
- Vibration
Operating: Random vibration 5-500 Hz, 10 minutes per axis,

approximately 0.2 g rms

Nonoperating: Random vibration 5 to 500 Hz, 10 minutes per axis,
approximately 2.41 g rms; and swept sine resonant
search, 5 to 500 Hz, 0.50 g (0-peak), 5-minute
resonant dwell at 4 resonances per axis.

What is a Specification

A Specification is a numeric value, or range of values, that bounds the
performance of a product parameter. The product warranty covers the
performance of parameters described by specifications. Products
shipped from the factory meet all specifications. Additionally, the
products sent to HP Customer Service Centers for calibration and
returned to the customer meet all specifications.

Specifications are verified by Calibration Procedures.

What is a Characteristic

Characteristics describe product performance that is useful in the
application of the product, but that is not covered by the product
warranty. Characteristics describe performance that is typical of the
majority of a given product, but not subject to the same rigor
associated with specifications.

Characteristics are verified by Function Tests.
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What is a Calibration Procedure

Calibration procedures verify products or systems operate within the
specifications. Parameters covered by specifications have a
corresponding calibration procedure. Calibration procedures include
both performance tests and system verification procedure. Calibration
procedures are traceable and must specify adequate calibration
standards.

Calibration procedures verify products meet the specifications by
comparing measured parameters against a pass-fail limit. The pass-fail
limit is the specification less any required guardband.

The term "calibration" refers to the process of measuring parameters
and referencing the measurement to a calibration standard rather than
the process of adjusting products for optimal performance.

What is a Function Test

Function tests are quick tests designed to verify basic operation of a
product. Function tests include operator’s checks and operation
verification procedures. An operator’s check is normally a fast test
used to verify basic operation of a product. An operation verification
procedure verifies some, but not all, specifications, and often at a lower
confidence level than a calibration procedure.

How the Help System is Organized

The HP 16600A/16700A logic analysis system is modular. HP offers a
choice of hardware and software tools you may install. As you add new
tools, you also add the tool’s help volume into the system.

When Help is accessed from the windows below the main icon bar, you
get the system help volume. If you access Help from any analyzer,
oscilloscope, pattern generator, or display/analysis tool window, you
get help for that specific tool.
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Searching Across all Help Volumes For best results, when you don’t know the
specific help volume you are in, simply search the index. The keyword index
search can search all installed help volumes.

Mouse Tip - How to navigate quickly through the Help System. (see
page 143)

Master list of Help Volumes

The following link takes you to a master list of all help volumes. (see
page 73)

More on using Help

For more information, see Using the Help System (see the Help On
Help help volume)
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Making Measurements

e QOverview - Starting a New Measurement (see page 77)

e Loading Configuration Files (see page 81)

e Changing a Configuration (see page 14)

e Saving Configuration Files (see page 83)

e Multiple Instrument Measurements (see page 12)

e The Setup Assistant (see the Setup Assistant help volume)

e Using Markers in the Display Tools (see the Markers help volume)
e Using Symbols (see page 152)

e “Using the Target Control Port” on page 172

e [Using an Expansion Frame (see page 101)

97



Chapter 1: HP 16600A/16700A Series Logic Analysis System
The Run Status Window

The Run Status Window

To be implemented...
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Japanese Help Volumes

A portion of the online help system has been localized to Japanese.

To view available Japanese help from a product window "Help" button,
select "Select Help Language -> Japanese" from the "Help" pulldown in the
workspace window. (If Japanese help is not available, English help will be
displayed.)

To always view English help from a product window "Help" button, select
"Select Help Language -> English" from the "Help" pulldown in the
workspace window.

Within the help system, display English help by accessing "Main System
Help" from any tool page, then clicking "Using Measurement Tools".

Within the help system, display Japanese help by accessing "Main System
Help" from any tool page, then clicking "Japanese Help Volumes".

To view the English and Japanese versions of a help volume at the same
time:

1.
2.

3.

Enter the English help system and navigate to the desired help page.

Select "Open Second Help Window (Japanese)" from the "Help" pulldown
in the workspace window.

Navigate to the desired Japanese help page.

These help volumes have been localized to Japanese:

HP 16600A/16700A Series Logic Analysis System Help (Japanese) (see the
HP 16600A/16700A Logic Analysis System (Japanese) help volume)

Measurement Examples (Japanese) (see the Measurement Examples
(Japanese) help volume)

Using the Listing Tool (Japanese) (see the Listing Display Tool
(Japanese) help volume)

Using the Chart Tool (Japanese) (see the Chart Display Tool (Japanese)
help volume)

Using the Distribution Tool (Japanese) (see the Distribution Display
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Tool (Japanese) help volume)

Using the Digital Waveform Tool (Japanese) (see the Wawveform Display
Tool (Japanese) help volume)

Working With Markers (Japanese) (see the Markers (Japanese) help
volume)

HP 16557D 1356MHz State/6500MHz Timing Logic Analyzer (Japanese) (see
the HP 16557D 140 MHz State/500 MHz Timing Logic Analyzer
(Japanese) help volume)

Using the Compare Tool (Japanese) (see the Compare Tool (Japanese)
help volume)

Using the File In Tool (Japanese) (see the File In Tool (Japanese) help
volume)

Using the File Out Tool (Japanese) (see the File Out Tool (Japanese)
help volume)

Using the Pattern Filter Tool (Japanese) (see the Pattern Filter Tool
(Japanese) help volume)

The Setup Assistant (Japanese) (see the Setup Assistant (Japanese)
help volume)

Using the Help System (Japanese) (see the Help On Help (Japanese)
help volume)

return to the main English help system page:
16600A/16700A Series Logic Analysis System Help (English) (see

the HP 16600A/16700A Logic Analysis System help volume)
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Using the HP 16701 A Expansion Frame

The HP 16700A logic analysis system can be expanded to a total of ten
slots by connecting an HP 16701 A expander frame. When connected,
the two frames create a tightly coupled system fully controlled by the
HP 16700A.

The HP 16600A logic analysis system is not expandable.

Expanded System Features

e (Combined total of ten module slots.

e Module arming/triggering between all modules.

e 2-nanosecond time correlation between modules.

e [xternal PORT IN and PORT OUT connectors on the HP 16700A frame.

Connecting the HP 16701A Expansion Frame

A 68-pin shielded flat cable connects the expansion frame to the main
frame. Connect one end of the cable to the HP 16700A port marked "To
HP 16701 A Expansion Frame". Connect the other end of the cable to
the HP 16701A port marked "HP 16700A".

System Power-Up

The HP 16701A expansion frame’s power supply is controlled by the
HP 16700A mainframe. Because the power is controlled by the
mainframe, the expansion frame’s power switch must be turned on
before the mainframe is turned on, or the expansion frame will not be
recognized as part of the system.
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The System Window

102



Chapter 1: HP 16600A/16700A Series Logic Analysis System
Navigation with Tabs

Navigation with Tabs
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Navigation with the Icon Bar
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Setup Assistant

The Setup Assistant window is used to start the automated process of
setting up a microprocessor analysis measurement.

File Manager

The File Manager window is used to perform the common tasks of
loading or saving measurement configurations. The File Manager has
all the standard functionality for performing operations on files and
directories on both the flexible and hard disk drives.

Workspace

The Workspace shows a complete graphical representation of the tools
and how they are connected for your measurement configuration. New
tools are primarily added from within Display tool windows, however,
for specific applications, the Workspace window may also be used.

For more specific configurations, or for modifications to an existing
configuration, use the Workspace to add or delete tools, or to add,
delete, or change the connection scheme between tools.

Intermodule

The Intermodule window shows a graphical representation of the
internal arming sequence between measurement modules, and any
external trigger connections to a target system or other instruments.

In measurements using multiple instruments or machines, the
Intermodule window is used to modify the order that measurement
modules are armed to trigger, and to compensate for any timing
deviations (skew adjust) between module probing.
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Run Status

The Run Status window is used to monitor the run function, and feed
back information on the progress of elements such as pre-store, trigger
status, and post-store.

System Administration

The System Administration window is used to setup system defaults,
network configurations, and perform maintenance on the operating
system file set. If you are working in a multi-user environment, you set
up user accounts in this dialog.

Demo Center

The Demo Center is used to learn about the main features of your logic
analysis system. By using the demo data files, you can view trace data
as it would normally appear, without needing to connect to a target
system.

Help

The Help icon in the System Icon Bar accesses the main help system
for the frame and system level operations.

All Instrument, Display, Analysis, and Utility tools have their own
specific help volumes.
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Automatic Measurement Configuration

Instrument Setup
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Accessing Display Tools

Cpens Display Tool
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System Terminology

Some of the terminology used in your logic analysis system has
changed with the release of the HP 16600A/16700A series. If you are
familiar with certain terminology, use this page to identify system
components by their old and new name.

For a full list of current system terminology, see the Glossary of System
Terms (see page 179).

e Old: preprocessor New: analysis probe
This hardware device is connected between your target system and a logic
analyzer to gather signals for analysis and display.

e (ld: software analyzer New: source correlation tool set
This software add-on allows you to correlate your trace data with the
source code that was used to generate the running program. The window
in which the decoded instructions are displayed is called the source
viewer.

e (Old: processor probe New: emulation module/emulation probe
These devices connect between your target system and your logic analysis
system for run/stop/break control of your target processor. An emulation
module plugs into a card slot in your logic analysis system, while an
emulation probe is an external device which can connect directly to your
logic analysis system or to a local network.

e state measurements may be referred to in the industry as synchronous or
periodic measurements.

* timing measurements may be referred to in the industry as asynchronous
measurements.
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Using the Mixed Signal Tab

A mixed signal measurement captures data and displays results from
more than one instrument tool. All displayed signals are time-
correlated and typically displayed in the same display tool. An example
of a mixed signal application would be when Using a Timing Analyzer
and an Oscilloscope (see page 123).

The Mixed Signal tab is used to import signals from other instruments
into the display tool.

Ideally, before you use the Mixed Signal tab to import a signal, the instrument
tool from which the signal will come should be configured and able to
successfully capture its own data set. If any required part of the configuration
is not correct, such as Arming or Time Tags, a Correlation Dialog (see

page 110) will appear to help correct the configuration.

1. Click the Mixed Signal tab.
Select the desired signal.

Click Conmnect.

o

Click Group Run. Running the measurement at this point makes the new
imported signals available for insertion.

ot

From the menu bar in the display window, click Edit, then select Insert.

6. From the Label Selection Dialog that appears, select the desired signal to
import, then click Apply.

7. Click OK.
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Using the Correlation Dialog

Two required elements of a multiple instrument configuration are the
Arming Signal and the Time Correlation of Data Sets. The
Correlation dialog is used to help you correct any configuration
problems with these two elements. If you run a measurement and the
Correlation dialog appears, reconfigure any inputs that show errors.

e Armed From — For each Input Name, set the Armed From field to either
the Group Run or another instrument. This allows the arming signal to
create an ordered triggering sequence between instruments. For more
information, refer to "The Arming Signal", in the Overview - Multiple
Instrument Configuration (see page 140).

e Time Tags — Each data set must be acquired in reference to a common
time base or time reference. Timing analyzers are always referenced to the
timebase of the measurement. However, if you are using a State analyzer,
you must set its Count field to Time (time tags). For more information,
refer to "Time Correlation of Data Sets", in the Overview - Multiple
Instrument Configuration (see page 140).
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Using the Analysis Tab

The logic analysis system allows you to use a variety of tools to filter,
compare, and display the measurement data. Depending on where in
the configuration you place these tools, you can generate multiple
views of only the data you are interested in seeing.

The Analysis tab is used to insert tools into your configuration from
the current display.

Using the Analysis tab to insert tools is a convenient way to expand a basic
configuration. However, if your measurement requires a more complex
reconfiguration, the system will notify you to perform the reconfiguration
from the Workspace window.

1. From the current display window, click the Analysis tab.
2. Highlight the desired tool to create within the configuration.

3. Click Create. If desired, you can verify the placement of the new tool from
the Workspace window.
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Adjusting Intermodule Skew

Skew is a small timing deviation between instruments configured in an
intermodule measurement. It is usually due to variances in internal
probing delays from one instrument to another. When desired, you
should adjust skew after new acquisitions are displayed.

The purpose of adjusting skew is to visually align waveforms in the
display so you can mark data or look for eye patterns within the
context of all displayed data sets.

In the following example, a Timing analyzer (bit 0) and an oscilloscope
(ch 1) are connected to the same glitch signal. Both waveforms are
displayed in the same Waveform display.

1.

10.

From the System window, click the logic analyzer icon, then select
Setup....

Configure a timing analyzer (see page 113) to trigger on the first
occurrence of the glitch.

From the System window, select the oscilloscope icon, then select Setup/
Display.

From the oscilloscope window, configure the oscilloscope (see page 114)
to trigger immediately.

From the Icon Bar in the System window, select the Intermodule icon.

From the Intermodule window, configure the Group Run Arming Tree (see
page 115) so the Group Rumn field arms the timing analyzer and the timing
analyzer arms the oscilloscope.

From the Intermodule window, select Navigate, then Analyzer N (your
analyzer), then select Wawveform....

From the Waveform display, select Group Run. This will update the
display showing the glitch.

From the Waveform display, select the Mixed Signal tab.

From the Mixed Signal tab, import the oscilloscope signal (see page 116)
into the Waveform display.
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11. From the menu bar in the Waveform display, select Options..., then select
Reference trigger..., then select the timing analyzer as the trigger
reference.

12. Select Group Run to update both data sets.

13. Place Markers (see page 117) on a common point and measure the
interval.

14. From the Intermodule window, select Intermodule Skew..., then Adjust
the skew (see page 117) to align displayed waveforms visually.

Configure the Timing Analyzer

The Sampling Tab

Configure the Sampling tab as shown below.

Analyzer<D>

[1M Sample Full Channel 300 HHz ]3| [Center ]3]
(1 ]3]

The Format Tab
1. Configure the Format tab with one label called Analyzer.

2. Assign the bit that maps to the input probe signal.
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The Trigger Tab
1. Under Trigger Functions, select Find edge, then select Replace.

2. Select the Edge tab and set the first edgel term to a Glitch.

stz | |
I |— E Setting Edgie 1, Analyzer

‘ o |7|_|_|;FIF

Configure the Oscilloscope

Channels Setup

1. Configure channel 1 as shown below. Turn channel 2 off.
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Trigger Setup

1. From the bottom of the oscilloscope window, select the Trigger field.

2. Set the Trigger Mode field to trigger Immediate.
This will cause the oscilloscope to trigger and begin running as soon as the
arming signal is received from the Timing analyzer.

Configure the Group Run Arming Tree

1. From the Intermodule window, select the analyzer icon, then select Group
Rumn as the arming device.

2. Select the oscilloscope icon, then select the analyzer as the arming device.
The result is an arming tree that has the analyzer armed when the Group
Run field is selected. Then the scope is armed, when the analyzer triggers
on the glitch, and the scope is configured to trigger immediately.
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Intermodule Skew“‘l

Fort In... |

Fort Out,.. |

Clock Synchronizationl

— Independent—— Group Run Arming Tree

Group Run =i

!

HHII
E

T

Configure the Waveform Display

1. Select the oscilloscope instrument.
2. Select Connect.

3. Expand the seconds per division and increase the height of the scope
signal for a better view of the glitch.

Search I Goto I Markers I Comments I Analy=is " Mixed Signal I

[Slot C: Scope<C> |%| To view data from another ACTIVE module or tool.

zelect the desired module or tool and press Connect,

Connect Disconnect
| | Then uwse Edit/Insert to select the new labels,

il

Channel C1
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Placing Markers for an Interval Reading.

1. From the Waveform display, select the Markers tab.
Place one Time marker on the leading edge of the scope glitch.

Place a second Time marker on the leading edge of the analyzer glitch.

&~ b

Read the difference between the two Time markers.

Search I Goto | Markersmiomments I Analy=is I Mixed Signal I

BB(Freloer J3j-0 [Tine J&Jfron (G2 ]3]- -s.466 s
4=

Secondssdiv — | (10,000 ns ﬁ Delay ﬁ
fratuzer ail

Channel C1

Adjust the Skew

Set the skew setting of the oscilloscope to the time difference you
measured between the two Time marker, then select Apply.

I Intermodule Skew

2GSass Oscilloscope C | 3ns

TS|

2M Sample 140 MHz States500 MHz Timing E |0 =
Ok | Apply | Cancel

The result of the skew adjustment moves the oscilloscope signal over
to the right (positive) so that it visually aligns itself with the analyzer
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trigger signal.

reruzer o1 [ B

Channel C1
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Starting Measurements from External Triggers

The analysis frame can automatically start a measurement using a
signal from an external instrument or system. The arming pulse is
connected to the PORT IN BNC on the rear panel of the analysis frame.

Port In Characteristics
The signal from the external instrument must have the following
characteristics.

Input Resistance = 4 kOhms
Levels = TTL, ECL, or User Defined from -4.0 V at 1.5 mA to +5 V at 1.6 mA
Input Voltage = -6 V at 1.5 mA to +6 V at 1.6 mA

Starting Measurements from External Triggers

1. Connect the arming pulse from the external instrument to the PORT IN
BNC connector on the analysis frame.

2. From the Intermodule window, select Port In.

3. Set the Port In voltage level and edge to match the arm signal from the
external instrument. You can set the analysis frame to match a TTL, ECL,
or user-defined level.

4. Select the large Group Run button and choose Group Run armed from
Port In.

5. Start the external instrument or system.

When the external instrument sends a pulse to the PORT IN BNC, the
Instrument tool(s) that are directly beneath the Group Run are armed
and begin searching for their respective trigger conditions.
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PortIn

TTL 4] 3]
[Rising 8]

You can configure an Instrument tool in the Group Run Arming Tree to
communicate its Trigger to the PORT OUT BNC connector on the rear
panel of the analysis frame. This signal is used to start or stop an
external instrument or system.

The Port Out Signal may be programmed through the User Interface to
transmit the instrument tool Trigger directly (Feedthrough Mode) or
transmit a pulse (Pulsed Mode) initiated by the instrument tool
Trigger.

The Polarity of the Port Out Signal is selectable as either Active High
or Active Low. Active High means that the Port Out Signal transitions
from low to high when Trigger occurs in the instrument tool associated
with Port Out. Active Low means that the Port Out Signal transitions
from high to low when Trigger occurs in the instrument tool associated
with Port Out.

Port Out may also be Disabled. When disabled, Port Out becomes a
high impedance (Tri-State) output and will not transition high or low,
regardless of the state of any associated instrument tool Trigger.
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When Port Out is disabled, the selectable fields associated with TYPE and
POLARITY are also disabled and thus have no meaning.

Port Out Signal Characteristics

The Port Out Signal is designed to drive a 50 Ohm Load. It is highly
recommended that, for good signal quality, the Port Out Signal be
terminated in 50 Ohms to Ground.

VOH (Output High Level)= >2.0 V into a 50 Ohm Load to Ground.
VOL (Output Low Level)= <0.5 V into a 50 Ohm Load to Ground.
Pulse Width in Pulsed Mode= Approximately 60 nanoseconds to 140 nanoseconds.

Triggering External Instruments

1. Connect the PORT OUT BNC connector on the analysis frame to the arm
or trigger input of the external instrument.

2. From the Intermodule window, select the PORT OUT icon, then select the
instrument tool you want the Port Out armed by.
When configured, the PORT OUT icon appears beneath the selected
module in the Group Run Arming Tree.

3. Select Port Out..., then configure the Port Out parameters.
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Port Out

Feedthrough |—
hctive High 3]
Enabled 3
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Using a Timing Analyzer and an Oscilloscope

In the following example we use an oscilloscope to trigger on a glitch
and a timing analyzer to capture bus data after the glitch. Both the
timing waveforms and the glitch are time-correlated and displayed in
the same display.

Before you begin configuring the measurement, connect the appropriate
probing (see page 144) for your measurement.

1. From the System window, select the oscilloscope icon, then select
Display....

2. From the oscilloscope window that appears, configure the oscilloscope
(see page 124) to trigger on a glitch.

3. From the System window, select the logic analyzer icon, then select
Setup....

4. From the analyzer window, configure the analyzer (see page 125) to
trigger on the first occurrence of data.

5. From the Icon Bar in the System window, select the Intermodule icon.

6. From the Intermodule window, configure the Group Run Arming Tree (see
page 127) so the Group Run field arms the oscilloscope and the
oscilloscope arms the logic analyzer.

7. From the Intermodule window, select Navigate, then Analyzer N (N=the
slot analyzer is in), then Waveform....

8. From the Waveform display that appears, select the Mixed Signal tab.

9. From the Mixed Signal tab, import the oscilloscope signal (see page 128)
into the Waveform display.

10. From the menu bar in the Waveform display, select Options..., then select
Reference trigger..., then select the oscilloscope as the trigger reference.

11. Select Group Run to run the measurement.
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Configure the Oscilloscope

Depending on the kind of glitch you are triggering on, the type of
probes used, and the speed of your system, your configuration could
vary from the one shown. In this example, we are triggering on a
positive glitch that is present for less that 20 ns.

Channel Setup
1. From the Channels tab in the oscilloscope window, select Setup....

2. From the Channels Setup dialog, configure channel 1 as shown below. Turn
channel 2 off.
Channels I Memories I Meazure I Markers I Display}

Setup, . | ¥ On
Scale:||1.00 Wediv

_I OFF
1.00 V/div

2,50 ¥

Offset:||2.50 W

Trigger Setup

1. From the Channels tab in the oscilloscope window, select Trigger....
Set the Mode field to Pattern.

Configure the pattern as a high pulse on channel 1.

Qualify the pattern to be present for less than 20 ns.

o ok

Select Close.
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Channel C1: '_H 7
x4
External: -

When the oscilloscope triggers on the glitch, the arm signal is sent to
the next instrument tool.

Remember, the arm signal does not automatically start the next instrument
tool. The arm signal simply tells the next instrument that it can start
evaluating its own trigger specification and run when trigger conditions are
satisfied.

Configure the Logic Analyzer

The Sampling Tab
1. Select the Sampling tab and set the analyzer to Timing Mode.
2. Set the Timing Mode Controls as shown below.
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Analyzer<D>

[1M Sample Full Channel 300 HHz ]3| [Center ]3]
(1 ]3]

The Format Tab
1. Select the Format tab and rename one label to Data.

2. Assign the bits that map to the input probe signals.

The Trigger Tab

1. Select the Trigger tab, then select the Trigger Functions tab.

2. Select the function Find anystate n times, then select Replace.
This will cause the Timing analyzer to trigger and begin running as soon as
the arming signal is received from the oscilloscope.
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Sampling I Format Trigger I Symbol I

Trigger Functions attern I Edgze I Range ]

Find edgze =
Find snystate n times E

Find edge AMD pattern F
[ | [

Replace | Inzert hefore |

‘H 1 | TRIGGER on "anystate" 1 time

NOTE:

Configure the Group Run Arming Tree

How you configure the Group Run Arming Tree determines if an
instrument tool runs as an independent tool or in a group. By default,
all instrument tools are Independent and in Single acquisition mode.

All multiple instrument configurations must be part of a Group Run to take
advantage of time-correlation and intermodule arming.

¢ [From the Intermodule window, select the oscilloscope icon and set it to be
armed by Group Run. Select the Timing analyzer and set it to be armed by
the oscilloscope.
The result is an arming tree that has the scope armed when the Group Run
field is selected. Then the timing analyzer is armed when the scope
triggers on the glitch. The analyzer is configured to trigger on the first data
it finds.

— Independent — Group Run Arming Tree

Group Run =i
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More about Independent and Group Run Configurations

Group Run allows all connected tools which are configured as Group
Run, to run when any Group Run field is selected. If any connected
tools are changed to Independent Run, they will not run with the
group.

Independent Run allows specific tools to remain in a connected group,
but run independently without affecting the run status of the other
instrument tools. To independently run an Instrument tool, you must
select Run from within one of that tool’s windows.

If any of the connected instrument tools are changed to Group Run, the
Run field for that particular tool, plus all tools connected to its output,
will change to Group Run.

Run/Group Run Function (see page 147)

Importing Signals into the Display

1. Select the desired Instrument tool.
2. Select Connect.

3. Select Group Run. Running the measurement at this point makes the new
imported signals available for insertion.

4. From the menu bar in the waveform display dialog, select Edzt, then select
Insert.

5. From the Label Dialog that appears, select the desired signal to import,
then select Apply.

6. Select Close.
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Waveform<1>

Slot C: 2 G5a/s Scope ¥ 1]
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Using Both Analyzers

In the following example we use a Timing analyzer to trigger on an
address pattern, and a State analyzer to capture the data that appears
after the address pattern. Both analyzers are from the same instrument
tool, and both the timing and state data sets are time-correlated.

Before you begin configuring the measurement, connect the appropriate
probing (see page 144) for your measurement.

1. From the System window, select the logic analyzer icon, then select
Setup.... The first analyzer window will appear.

2. From the first analyzer window, configure a Timing analyzer (see
page 131) to trigger on the first occurrence of a desired edge and pattern.

3. From the analyzer window, select Navigate, then Activate Modules, then
select the second analyzer from the same slot. This analyzer is marked by
an N2, where N is the slot the analyzer is installed in, and 2 designates the
second analyzer.

When you activate the second analyzer, a second analyzer window marked
N2 appears.

4. From the Settings tab of the first analyzer, configure the Arming Tree (see
page 133) so the Timing analyzer (first analyzer) is armed by Run, and the
State analyzer (second analyzer) is armed by the Timing analyzer.

5. From the second analyzer, configure a State analyzer (see page 132) to
trigger on the first occurrence of any data.

6. From either analyzer window, select Nawvigate, then Analyzer N, then
select Listing.

7. From the Listing window, Select Run to execute the measurement and
display data.
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Configure the Timing Analyzer

The Sampling Tab

From the Sampling tab, set the analyzer to Timing Mode, and
configure the Timing Mode Controls as shown below.

Analyzer<D>

[1M Sample Full Channel 300 HHz ]3| [Center ]3]
(1 ]3]

The Format Tab
1. Rename the label to Address.

2. Assign the bits that map to the input probe signals.

The Trigger Tab

1. From the Trigger Functions tab, select Find edge AND pattern, then
select Replace.

2. From the Pattern tab, assign Patternl the desired pattern you want to
trigger on. In this example we use the pattern "55" Hex. By default, Edgel
is set to don’t care which is OK for this example.
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Configure the State Analyzer

The Sampling Tab

1. From the second analyzer window, select the Sampling tab, and set the
analyzer to State Mode.

2. Configure the State Mode Controls as shown below.

Analyzer<02> v

[Center ]3]

The Format Tab

1. From the Fomat tab, rename the label to Data.
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2. Assign the bits that map to the input probe signals.

The Trigger Tab

1. From the Trigger Function tab, select Find anystate n times.

2. Select Replace.
This will cause the State analyzer to trigger and begin running as soon as
the arming signal is received from the Timing analyzer.

Configure the Arming Tree

How you configure the Arming Tree determines which analyzer sends
the arm signal to the other. By default both analyzers are armed by the
Run field.

1. From the Settings tab, select Arming Control.

2. From the Arming Tree dialog that appears, set Analyzer N to be armed
from Run, and Analyzer N2 to be armed from Analyzer N as shown below.
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Group Run Arming Tree

The Group Run Arming Tree is found in the Intermodule window. You
access the Intermodule window by clicking the Intermodule icon in the
Icon Bar of the System window.

— Independent — Group Run Arming Tree

Group Run =i

!

/\’_I-_-'Z"
T

.
Use the Group Run Arming Tree to configure Instrument tools into a
group where all run functions are referenced to an arming signal. If
Instrument tools are not included in a Group Run, they are configured
as Independent and are not tied to an arming signal. By default, all

instrument tools placed on the workspace are configured as
Independent Run.

When you select the Group Run field, the following sequence of
events occur:

1. When the run field is selected, all tools that are not directly armed from
the run field or port in signal, begin to evaluate their trigger specification.
They step through their trigger sequence until they get to the point where
they are waiting for an arm signal.

2. The first tool in the tree begins evaluating its trigger specification and
triggers when it is met. At the point of trigger, the arm signal is sent down
to the next tool in the tree.

3. From this point, all subordinate tools are ready and waiting in their
sequences for the arm signal. When the signal is received, they react
immediately with a trigger, store, or what ever remains in their trigger
sequence. As each tool triggers, the arm signal is sent down to the next
tool.

For more information on the Run/Stop function, refer to Run/Stop (see
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page 147).

For more information on using the Group Run in measurements, refer
to the following examples:

“Using a Timing Analyzer and an Oscilloscope” on page 123

“Using Both Analyzers” on page 130
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Arming Tree

The Arming Tree is found under Arming Control in the Logic
Analyzer’s Trigger tab - Settings tab.

Use the Arming Tree to configure the separate analyzers into a group
where their run functions are referenced to the arming signal.

The order in which the analyzers appear in the Arming Tree
determines the order they receive the arming signal. The arm signal
does not automatically start the next analyzer. The arm signal simply
tells the next analyzer that it can start evaluating its own trigger
specification and run when its trigger conditions are satisfied.

If a trigger specification in an analyzer has multiple sequence levels,
you can specify which sequence level to send the arm signal to. This is
useful when specifying cross-triggering within a single analyzer tool.

For more information on using two analyzers in a measurement, refer
to the following example.

“Using Both Analyzers” on page 130
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Overview - Multiple Analyzer Configuration

A multiple analyzer configuration consists of both analyzers from the
same logic analyzer instrument tool used together in a measurement.
In this type of configuration, each analyzer captures its own data set.
All data sets are then viewed in one or more display tools.

" Timing

Analyzer B % Waveform =1
State

Analyzer B2 g}—D Listing =1=

Configuration Shown in the Workspace Window

Important elements of a multiple analyzer configuration are the
arming control and the teme correlation of the separate data sets.
There is no analyzer-to-analyzer skew adjustment.

The Arming Control

When using both analyzers in a measurement, you must coordinate the
run function of both analyzers. This is done by the Arming Control in
the analyzer’s Trigger window. By configuring the Machine Arming
Tree (see page 137), you route the arming signal through both
analyzers.

When the measurement is run, the arming signal notifies each analyzer
in the Arming Tree when it’s their turn to run. Depending on the
purpose of the measurement, all analyzers could trigger immediately
when the arm signal is received, or, each analyzer could trigger
according to its own trigger specification.

The arming signal can originate either when the measurement is run,
(see page 147) or by an external source connected through a Port In
connector.

Time Correlation of Data Sets

When multiple analyzers have their arming control coordinated to an
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arming signal, they typically are also teme-correlated. That is, each
data set is acquired in reference to a common time base or time
reference. A big benefit of time correlation is the ability to display
multiple data sets in the same display window with all data time-
stamped and aligned relative to each other.

Timing analyzers are always referenced to the time base of the
measurement. However, if you are using a State analyzer, you must set
its Count field (see page 142) to Time.

See Also

For an example of a multiple analyzer measurement, refer to Using
Both Analyzers. (see page 130)
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Overview - Multiple Instrument Configuration

A multiple instrument configuration consists of more than one
Instrument tool grouped together in a measurement. In this type of
configuration, each instrument tool captures its own data set. All data
sets are then typically viewed in the same Display tool.

Analyzer B Waveform-=1=

2 G3als Socope

Configuration Shown in the Workspace Window

Important elements of a multiple instrument configuration are the
arming signal, the time correlation of the separate data sets, and the
skew adjustment between instruments.

The Arming Signal

When using multiple instrument tools in a measurement, you must
coordinate the run function of all instruments. This is done by the
arming signal in the Group Run Arming Tree. (see page 135) When the
measurement is run, the arming signal notifies each instrument in the
arming tree when its their turn to run. Depending on the purpose of
the measurement, all instruments could trigger immediately when the
signal is received, or, each instrument could trigger according to its
own trigger specification.

The arming signal can originate either when the measurement is run
(see page 147) by selecting the Group Run field, or by an external
source connected through a Port In connector.

Time Correlation of Data Sets

When multiple instrument tools have their run control coordinated to
an arming signal, they typically are also tzme-correlated. That is, each
instrument knows the time relationship between each others trigger,
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and also that it knows each sample’s time relationship to its own
trigger.

A big benefit of time correlation is the ability to display multiple data
sets in the same display window with all data time-stamped and aligned
relative to each other.

Timing analyzers are always referenced to the time base of the
measurement. However, if you are using a State analyzer, you must set
its Count field (see page 142) to Time.

Skew Adjustment

Skew is a small timing deviation between the different instruments
configured in the same measurement. It is usually due to variances in
internal probing delays from one instrument to another. You
compensate for any variations using the Intermodule Skew (see

page 112) adjustment.

See Also

For another example of a multiple instrument measurement, refer to
Using a Timing Analyzer and an Oscilloscope. (see page 123)
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Count Field

Before the data set from a State analyzer can be viewed in reference to
other data sets in the same measurement, the data must be acquired as
time-correlated data.

To time-correlate the data of a State analyzer, set the Count field under
the Settings tab Time.

A benefit of time-correlated data sets is that you can place global
markers at data points in one data set and view data from another data
set that occurred at the same time.
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Help - How to Navigate Quickly

1. Place mouse cursor anywhere in a help window.
2. Press the right mouse button.

3. Select desired destination.

_______ H Help
II‘ i Backtrack
X 2]

Home Topic

You can also access all navigation and search commands from the help
window menu bar.
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Analyzer Probing Overview

The figures below shows a variety of simple probing connections. The
specific probe type, number of probes, and location on the target
circuit depends on your particular measurement.

For equivalent circuit diagrams and pinouts, see the description of the
probe type in the Logic Analysis System and Measurement Modules
Installation Guide. If you have misplaced the Logic Analysis System
and Measurement Modules Installation Guide, you can download
the latest version from the Web at <URL: http://www.hp.com/go/
LogicAnalyzer-Manuals/ >

Probe Lead-to-Board Connection

The standard lead set plugs directly into any .1-inch grid with 0.026 to
0.033-inch diameter round pins or 0.025-inch square pins. All probe
tips work with the HP 5059-4356 surface mount grabbers and the

HP 5959-0288 through-hole grabbers.
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Adapter-to-Board Connection

Probe Cable

L 4 L 4
Probe Cable
L 4
Termination Adapter
01650-63203 High-Density

Terminaticn
Adapter
Es3484

lr PC Board

PC Board l

Both the 01650-63203 and the E56346A adapters include termination
for the logic analyzer. The 01650-63203 termination adapter plugs into
a 2 x 10 pin header with 0.1 inch spacing. The E5346A high-density
adapter connects to an AMP "Mictor 38" connector. If possible, use
support shrouds around the Mictor connector to relieve strain and
improve connections.

Direct Pod-to-Board Connection

If you provide proper termination as part of the target board, you can
plug the pod directly into the ©3M 2520-series, or similar alternative
connector. Suggested termination is shown in the Logic Analysis
System and Measurement Modules Installation Guide.

Also use this termination with the HP E5351A high-density, non-
terminated adapter.

Pod-to-Analysis Probe Connection

Analysis probes (formerly called preprocessors) are microprocessor-
specific interfaces that make it easier to probe buses. Generally,
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analysis probes consist of a circuit board that attaches to the
microprocessor (possibly through an adapter) and a configuration file.
The configuration file sets up the logic analyzer’s clocks and labels
correctly, and may include an inverse assembler. The circuit board
provides access to logical groups of pins through headers designed to
connect directly to the logic analyzer.

The easiest way to set up a measurement with an analysis probe is the
Setup Assistant. (see the Setup Assistant help volume) The Setup
Assistant asks you questions about your measurement and then shows
you just the information you need to set up the probe correctly. It also
loads the proper configuration files.
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Run/Group Run Function

e Setting a tool for independent or Group Run (see page 148)
e Setting Single or Repetitive Run (see page 149)

e  “Checking Run Status” on page 149

Understanding Run/Run All/Group Run

The Run/Run All/Group Run buttons initiate data capture in the
instrument tools you have configured. When an instrument tool is
connected to analysis or display tools, any of the tools can initiate a
run. When two or more instrument tools are configured, you can run
them independently or as a group. Two or more instruments running as
a group is called an Intermodule measurement.

Use the Intermodule Window (see the HP 16600A/16700A Logic
Analysis System help volume) to coordinate the run function of
multiple instruments as a "Group Run". A common "Group Run"
configuration is to run the instrument tools at the same time. A more
advanced measurement is to configure one instrument to arm another
instrument, each with their own trigger conditions.

e Run appears in the setup dialog and icon menu of an instrument if it is not
part of an Intermodule measurement.

e Group Run appears in the setup dialog and icon menu of each tool if two or
more instruments are configured for an Intermodule measurement.

e Run All always appears in the System, Workspace and Run Status
windows, and initiates a run in all configured instruments, whether they
are run independently or are part of a Group Run.

Intermodule measurements are configured between individual
instruments. Arming between two machines that belong to one
analyzer is configured in the Arming Info... dialog found in the Trigger
window of the analyzer.

Understanding Stop/Stop_All/Cancel

e Stop will terminate an individual instrument measurement that is running.
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(perhaps waiting for a trigger condition)

e Stop All, when selected from the Workspace, will terminate running
measurements from all instruments currently on the Workspace.

e (Cancel will terminate the processing of trace data from an instrument to an
analysis or display tool connected to its output.

See Also “Demand Driven Data” on page 150

Setting a tool for independent or Group Run

Use the Intermodule Window to change between Group Run and
independent Run.
e (lick the Intermodule icon in the System Window, OR

e Use Navigate->System->Intermodule

In the Intermodule window, move instruments between independent
Run and Group Run by clicking the icon and selecting the desired
arming source. All instruments in "Group Run" will run simultaneously.
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Setting Single or Repetitive Run

A single measurement will stop after memory is full or a store
qualification is met. A repetitive measurement executes successive
Single measurements until Stop is selected.

When a single or repetitive measurement is stopped, only data that has
been captured to that point is available for viewing.

Select single or repetitive by right-clicking on the Run button in the
tool’s setup window.

| Run
4+ Single
Repetitive

If you have problems displaying trace data when running Repetitive
measurements, see “Demand Driven Data” on page 150.

Checking Run Status

The Run Status dialog provides status information about the currently
configured instruments, and the status of the run with respect to the
trigger specification.

To access the Run Status dialog:
e The Run Status icon in the System Window, OR

e Navigate->System->Run Status
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[run pil |

Popup On Severity: o Info W Larning
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Clear Messazes Close E

Demand Driven Data

When an analyzer measurement occurs, acquisition memory is filled
with data that is then transferred to the display memory of the analysis
or display tools you are using, as needed by those tools. In normal use,
this demand driven data approach saves time by not transferring
unnecessary data.

Since acquisition memory is cleared at the beginning of a
measurement, stopping a run may create a discrepancy between
acquisition memory and the memory buffer of connected tools. Without
a complete trace of acquisition memory, the display memory will
appear to have 'holes’ in it which appear as filtered data.

This situation will occur in these cases:

e [f you stop a repetitive measurement after analyzer data has been cleared
and before the measurement is complete.

e [fatrigger is not found by the analyzer and the run must be stopped to
regain control.

To make sure all of the data in a repetitive run is available for viewing:
¢ In the workspace, attach a Filter tool to the output of the analyzer.
e In the Filter, select "Pass Matching Data"

e In the filter terms, assure the default pattern of all "Don't Cares" (Xs).
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This configuration will always transfer all data from acquisition
memory. While this configuration will increase the time of each run, it
will guarantee that repetitive run data is available regardless of when it
is stopped.
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The Symbols Tab

The Symbols tab offers control of the symbols capabilities. Symbols
represent patterns and ranges of values found on labeled sets of bits.
Two kinds of symbols are available:

e  Object File Symbols. These are symbols from your source code and
symbols generated by your compiler.

e User-Defined Symbols. These are symbols you create.
To load symbols, click one of the following;:

e “To Load Object File Symbols” on page 154

e “To Load User-Defined Symbols” on page 171

Symbols are available for all state and timing analyzers. Each label
listed in the Format menu can have its own group of symbols
associated with it.

“User-Defined Symbols” on page 170

“Setting Up Object File Symbols” on page 154

“Using Symbols In The Logic Analyzer” on page 165

e “Displaying Data in Symbolic Form” on page 153
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Displaying Data in Symbolic Form

You can display data in symbolic form in some of the display tools, such
as the Listing display and the Waveform display.

To View Symbolic Values in a Waveform Display
1. Right-click the label name where you want to display symbolic values.
2. Select Change attributes....
3. In the Attribute Dialog:
¢ Set ShowValue to On.
e Set Base to Symbols or Line#.
e Click OK.

The symbolic names for the values now appear in the overlayed bus
waveform.

To View Symbolic Values in a Listing Display

1. Right-click the numeric base of the label where you want to display
symbolic values.

2. Set the numeric base to Symbols or Line#.
The symbolic names for the values now appear instead of numeric data.
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Setting Up Object File Symbols

Object file symbols can include variable names, procedure or function
names, and source file names with line numbers. The linkage between
symbol names and address or data values comes from one of two
sources:

e Object files that are created by your compiler/linker.

e ASCII symbol files you create with a text editor.

To use object file symbols

1. Generate an object file with symbolic information using your software
development tools.

2. If your language tools cannot generate object file formats that are
supported by the logic analyzer, create an ASCII symbol file (see
page 158).

3. Load the object file (see page 154) or ASCII symbol file into the logic
analyzer.

4. If necessary, relocate sections of your code (see page 156).

“Using Symbols In The Logic Analyzer” on page 165

“Symbol File Formats” on page 1567

To Load Object File Symbols

1. Select the Symbol tab and then the Object Flile tab.

2. Select the label name you want to load object file symbols for.
In most cases you will select the label representing the address bus of the
processor you are analyzing.

3. Specify the directory to contain the symbol database file (.72s ) in the field
under, Create Symbol File (.ns) in This Directory. Click Browse... if you
wish to find an existing directory name.
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4. Inthe Load This Object/Symbol File For Label field, enter the object file
name containing the symbols. Click Browse... to find the object file and
click Load in the Browser dialog.

If your logic analyzer is NF'S mounted to a network, you can select object
files from other servers.

To reload object file symbols

1. Select the object file/symbol file to reload from the Object Files with
Symbols Loaded For Label field.

2. Click the Reload button.

Value update

The values of the object file symbols being used as terms or as SPA
state-interval ranges will be updated automatically each time the object
file symbols are reloaded.

Configuration file save

The name of the current object file is saved when a configuration file is
saved. The object file will be reloaded when the configuration is loaded.

Multiple files

You can load the same symbol file into several different analyzers, and
you can load multiple symbol files into one analyzer. Symbols from all
the files you load will appear together in the object file symbol selector
that you use to set up resource terms.

Object file versions

During the load process, a symbol database file with a .7s extension
will be created by the system. One .ns database file will be created for
each symbol file you load. Once the .7s file is created, the Symbol
Utility will use this file as its working symbol database. The next time
you need to load symbols into the system, you can load the .7s file
explicitly, by placing the .7ns file name in the Load This Object/Symbol
Flile For Label field.

If you load an object file that has been loaded previously, the system
will compare the time stamps on the .7s file and the object file. If the
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object file is newer, the .7ns file will be created. If the object file has not
been updated since it was last loaded, the existing .ns file will be used.

“Using Symbols In The Logic Analyzer” on page 165

“Symbol File Formats” on page 157

Relocating Sections of Code

Use this option to add offset values to the symbols in an object file. You
will need this if some of the sections or segments of your code are
relocated in memory at run-time. This can occur if your system
dynamically loads parts of your code so that the memory addresses
that the code is loaded into are not fixed.

To Relocate a Single Section of Code
1. Click the Symbol tab and then the Object F'ile tab.

2. In the Object Files with Symbols Loaded For Label list, select the file
whose symbols you wish to relocate.

3. Select the Relocate Sections... button.

4. In the Section Relocation dialog, click the field you wish to edit in the
section list.

5. Type in the new value for that field and press Enter on your keyboard.
6. Repeat steps 4 through 6 above for any other sections to be relocated.

7. Click Close.

To Relocate All Sections of Code
1. Click the Symbol tab and then the Object Flile tab.

2. In the Object Files with Symbols Loaded For Label list, select the file
whose symbols you wish to relocate.

3. Select the Relocate Sections... button.

4. Type the desired offset in the Offset all sections by field. The offset is
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applied from the linked address or segment.
5. Click Apply Offset.
6. Click Close.

To Delete Object File Symbol Files

1. Click the Symbol tab, and then the Object Flile tab.

2. Select the file name you want to delete in the text box labeled, Object
Files with Symbols Loaded For Label.

3. Click Unload.

Symbol File Formats

The logic analysis system can read symbol files in the following
formats:

e OMF96

e OMFx86

e [EEE-695

e ELF/DWARF
e ELF/stabs

e TICOFF

For ELF/DWARF1, ELF/stabs, and ELF/stabs/Mdebug files, C++
symbols are demangled so that they can be displayed in the original
C++ notation. To improve performance for these ELF symbol files, type
information is not associated with variables. Hence, some variables
(typically a few local static variables) may not have the proper size
associated with them. They may show a size of 1 byte and not the
correct size of 4 bytes or even more. All other information function
ranges, line numbers, global variables and filenames will be accurate.
These behaviors may be changed by creating a readers.ini (see
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page 163) file.

“Creating ASCII Symbol Files” on page 168Creating ASCII Symbol Files

“Creating a readers.ini File” on page 163Creating a readers.ini File

NOTE:

Example

Creating ASCII Symbol Files

If your language tool chain does not produce object files in a supported
format, you can create an ASCII symbol file to define symbols. You can
also use an ASCII symbol file to define symbols that are not included in
your object file.

You can create an ASCII symbol file using any text editor that supports
ASCII format text. Each entry in the file you create must be a string of
ASCII characters consisting of a symbol name followed by an address
or address range. The address or address range must be a hexadecimal
number. It must appear on the same line of the text file as the symbol
name and it must be separated from the symbol name by one or more
blank spaces or tabs. Address ranges must be in the following format:

beginning address..ending address

Two formats are available for creating ASCII symbol files:
“Simple Format” on page 158

“Record Header Format” on page 159

It is possible to generate ASCII symbol files from the symbol or load map
output of most language tools.

Simple Format

An ASCII symbol file can be a simple list of name/address pairs.

main 00001000..00001009
test 00001010..0000101F
varl 00001E22 #this is a variable
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This example defines two symbols that correspond to address ranges
and one point symbol that corresponds to a single address.
Record Header Format

An ASCII symbol file can be divided into records using key words,

called record headers. The different records allow you to specify

different kinds of symbols, with differing characteristics. An ASCII
symbol file can contain any of the following kinds of records:

“Start Address” on page 160
“Sections” on page 160
“Functions” on page 160
“Variables” on page 162

“Source Line Numbers” on page 161
“Comments” on page 162

The record headers must be enclosed in square brackets, like this:
[HEADERY]. If no record header is specified, the lines following are
assumed to be symbol definitions in one of the VARIABLES formats:

variable address
variable start..end
variable start address size

Here is an ASCII symbol file that contains several different kinds of
records.

[SECTIONS]

prog 00001000..0000101F
data 40002000. .40009FFF
common FFFF0000O..FFFF1000
[FUNCTIONS]

main 00001000..00001009
test 00001010..0000101F
[VARIABLES]

total 40002000 4

value 40008000 4
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[SOURCE LINES]
File: main.c

10 00001000
11 00001002
14 0000100A
22 0000101E

File: test.c

5 00001010
7 00001012
11 0000101A

Start Address . Format

[START ADDRESS]
address

address - The address of the program entry point, in hexadecimal.

Example

[START ADDRESS]
00001000

Functions . Use FUNCTIONS to define symbols for program
functions, procedures or subroutines.

Format

[FUNCTIONS]
func_name start..end

Sunc_name - A symbol representing the function name.
start - The first address of the function, in hexadecimal.

end - The last address of the function, in hexadecimal.

Example

[FUNCTIONS]

main 00001000..00001009
test 00001010..0000101F

Sections . Use SECTIONS to define symbols for regions of memory,
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such as sections, segments, or classes.

Format

[SECTIONS]
section name start..end attribute

section_name - A symbol representing the name of the section.
start - The first address of the section, in hexadecimal.

end - The last address of the section, in hexadecimal.

attribute - (optional) Attribute may be one of the following:

NORMAL (default) - The section is a normal, relocatable section, such
as code or data.

NONRELOC - The section contains variables or code that cannot be
relocated. In other words, this is an absolute segment.

Example

[SECTIONS]

prog 00001000..00001FFF

data 00002000..00003FFF

display io 00008000..0000801F NONRELOC

If Section definitions are used in an ASCII symbol file, any subsequent
Function or Variable definitions must fall within the address ranges of one of
the defined Sections. Those Functions and Variables that do not will be
ignored by the Symbol Utility.

Source Line Numbers . Use SOURCE LINES to associate addresses
with lines in your source files.

Format

[SOURCE LINES]
File: file name
line# address

file_name - The name of a file.

line# - The number of a line in the file, in decimal.
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address - The address of the source line, in hexadecimal.

Example

[SOURCE LINES]
File: main.c

10 00001000
11 00001002
14 0000100A
22 0000101E
See Also Using the Source Viewer (see the Listing Display Tool help volume)

Variables. You can specify symbols for variables using:
e The address of the variable.

e The address and the size of the variable.

e The range of addresses occupied by the variable.

If you give only the address of a variable, the size is assumed to be 1

byte.

Format

[VARIABLES]

var name start [size]
var_name start..end

var_name - A symbol representing the variable name.
start - The first address of the variable, in hexadecimal.
end - The last address of the variable, in hexadecimal.

size - (optional) The size of the variable, in bytes, in decimal.

Example

[VARIABLES]

subtotal 40002000 4
total 40002004 4

data_array 40003000..4000302F
status_char 40002345

Comments . Any text following a # character is ignored by the Symbol
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Utility. The # can be used to comment a file. Comments can appear on a
line by themselves, or on the same line, following a symbol entry.

Format

#comment text

Example

#This is a comment

Reader options

Creating a readers.ini File

You can change how an ELF/Dwarf or ELF/stabs symbol file is
processed by creating a reader.ini file.

1. Create the reader.ini file on your workstation or PC.

2. Copy the file to /hplogic/symbols/readers.ini on the logic analysis system.

C++Demangle

1= Turn on C++ Demangling (Default)
0= Turn off C++ Demangling

C++DemOptions

803= Standard Demangling (Default Elf/Dwarf)

203= GNU Demangling (Default E1f/Stabs)

403= Lucid Demangling

800= Standard Demangling without function parameters
200= GNU Demangling without function parameters

400= Lucid Demangling without function parameters

MaxSymbolWidth

80= Column width max of a function or variable symbol
Wider symbols names will be truncated. (Default 80 columns)

ReadElfSection

2= Process all globals from ELF section (Default)
Get size information of local variables
1= Get size information of global and local variables
Symbols for functions will not be read, and
only supplemental information for those symbols in the Dwarf
or stabs section will be read.
0= Do not read the Elf Section
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If a file only has an ELF section this will have no effect and the ELF
section will be read completely. This can occur if the file was created
without a "generate debugger information" flag (usually -g). Using the -
g will create a Dwarf or Stabs debug section in addition to the ELF
section.

DwarfiNoType

1= Use the new fast symbol reader for Dwarfl (Default)
0= Use the previous version of the symbol reader

This symbol reader will be slow and may not be able to process all files.
In addition the older symbol reader does not do C++ demangling. This
symbol reader does process type information, so the sizes of local static
and global variables will be processed.

Do not use this option unless you are having trouble reading the
symbol file. This option will most likely be deleted in the future.

[ReadersElf]

c

c
ReadElfSection=1
DwarflNoType=1
MaxSymbolWidth=60
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Using Symbols In The Logic Analyzer

The ways symbols can be used in the logic analyzer are listed below:

“Using Symbols As Trigger Terms” on page 165

“Using Symbols as Search Patterns in Listing Displays” on page 166
“Using Symbols as Trigger Terms in the Source Viewer” on page 166
“Using Symbols as Pattern Filter Terms” on page 167

“Using Symbols as Ranges in the Software Performance Analyzer” on
page 167

“Displaying Data in Symbolic Form” on page 153

NOTE:

Using Symbols As Trigger Terms

You can use either one or both types of symbols as terms within your
trigger sequence:

1.

Object File Symbols.
User-Defined Symbols.

At the bottom of the analyzer Trigger window, click the label button next
to one of the resource terms, and select Replace.

In the Resource selection dialog, select a label to be used in your trigger
sequence.
Use a label that has symbols loaded.

Set the numeric base of the trigger term to Symbols or Line #s.
Click the button to the right of the numeric base field.

In the Symbol Selector (see page 167) dialog, select the symbol you want
to use.

The values of object file symbols used as trigger terms are automatically
updated when the object file symbols are reloaded (see page 154).
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Setting Up a Trigger (see the HP 16600A-Series 100 MHz State/250
MHz Timing Logic Analyzer help volume)

See Also

Using Symbols as Search Patterns in Listing

Displays

1. Under the Search tab in the Listing display, click Advanced searching.
In the Goto Pattern dialog, click Define.

In the Search Pattern dialog, select the Symbols numeric base.

Select Pattern, Range, Not Pattern, or Not Range.

Click the button to the right of the numeric base field.

S T

In the Symbol Selector (see page 167) dialog, select the symbol you want
to use.

Go to an Exact Pattern. (see the Listing Display Tool help volume)

See Also

Using Symbols as Trigger Terms in the Source
Viewer
1. Inthe Source Viewer menu bar, click Trace, and select Trace Setup.

2. In the Source Line Trigger dialog, select Symbols or Line #s in the
numeric base field.

3. Select Pattern, Range, Not Pattern, or Not Range.
4. Click the button to the right of the numeric base field.

5. In the Symbol Selector (see page 167) dialog, select the symbol you want
to use.

To modify the trace setup. (see the Listing Display Tool help volume)
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Using Symbols as Pattern Filter Terms

1. Click the numeric base field beside the selected filter term, and select
Symbols or Line #s.

Select Pattern, Range, Not Pattern, or Not Range.
Select Remove Matching Data or Pass Matching Data, as desired.

Click the button to the right of the numeric base field.

A I T

In the Symbol Selector (see page 167) dialog, select the symbol you want
to use.

See Also

Using Symbols as Ranges in the Software
Performance Analyzer
1. In the SPA tool, click Symbols in the Define Ranges dialog.

2. Inthe Symbol Selector (see page 168) dialog, select the symbol or group of
symbols you want to use as ranges in your measurement.

Defining State Interval Ranges. (see the System Performance
Analyzer help volume)
Using the Symbol Selector Dialog

1. In the Symbol Selector dialog, select the symbol you want to use. All of
your symbols for the current label, regardless of type, will be available in
the dialog.

e Use the Search Pattern (see page 168) field to filter the list of symbols
by name. You can use the Recall button to recall a desired Search
Pattern.

e Use the Find Symbols of Type selections to filter the symbols by type.
2. Click the symbol you want to use in the list of Matching Symbols.
3. If you are using object file symbols, you may need to:

e Set Offset By (see page 169) to compensate for microprocessor
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prefetches.
e Set Align to x Byte (see page 169) to trigger on odd-byte boundaries.
4. Select the Beginning, End, or Range of the symbol.

5. Click OK.
The name of your symbol now appears as the value of the resource term.

6. Click Cancel to exit the Symbol Selector dialog without selecting a
symbol.
Using the Symbol Selector Dialog

1. Inthe Symbol Selector dialog, select the symbol you want to use. All of
your symbols, regardless of type, will be available in the dialog.

e Use the Search Pattern (see page 168) field to filter the list of symbols
by name. You can use the Recall button to recall a desired Search
Pattern.

e Use the Find Symbols of Type selections to filter the symbols by type.

2. Click and drag to select the symbols you want to use in the list of
Matching Symbols.

e (lick Select All to select all symbols in the list.
e (lick Unselect All to unselect all symbols in the list.

3. Click Add Selected Symbols To Range List to place the selected symbols
into the Current ranges list in the Define Ranges dialog.

4. Click Close to exit the Symbol Selector dialog.

Search Pattern

Use this field to locate particular symbols in the symbol databases. To
use this field, type in the name of a file or symbol. The system searches
the symbol database for symbols that match this name. Symbols that
match appear in the list of Matching Symbols. You can also use
wildcard characters to find symbols.

Asterisk wildcard (¥*)

The asterisk wildcard represents "any characters." When you perform a
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search on the symbol database using just the asterisk, you will see a list
of all symbols contained in the database. The asterisk can also be
added to a search word to find all symbols that begin or end with the
same letters. For example, to find all of the symbols that begin with the
letters "st", select the Search Pattern field and type "st*".

Align to x Byte Option

Most processors do not fetch instructions from memory on byte
boundaries. In order to trigger a logic analyzer on a symbol at an odd-
numbered address, the address must be masked off. The "Align to x
Byte" option allows you to mask off an address.

Assume the symbol "main" occurs at address 100F. The processor being
probed is a 68040, which fetches instructions on long-word (4-byte)
boundaries. In order to trigger on address 100F, the Align to x Byte
option sets the two least-significant address bits to "don’t cares". This
qualifies any address from 100C through 100F.

Offset By Option

The Offset By option allows you to add an offset value to the starting
point of the symbol that you want to use as a term. You might do this in
order to trigger on a point in a function that is beyond the preamble of
the function, or to trigger on a point that is past the prefetch depth of
the processor. Setting an offset helps to avoid false triggers in these
situations. The offset specified in the Offset By field is applied before
the address masking is done by the "Align to x Byte" option.

An 80386 processor has a prefetch depth of 16 bytes. Assume functions
Sfuncl and func2 are adjacent to each other in physical memory, with
Sunc following funcl. In order to trigger on func? without getting a
false trigger from a prefetch beyond the end of funci, you need to add
an offset value to your trigger term. The offset value must be equal to
or greater than the prefetch depth of the processor. In this case, you
would add an offset of 16 bytes to your trigger term. You would set the
value of the "Offset By" field to 10 hex. Now, when you specify func as
your trigger term, the logic analyzer will trigger on address func2+10.
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User-Defined Symbols

“To Create User-Defined Symbols” on page 170
“To Replace User-Defined Symbols” on page 170
“To Delete User-Defined Symbols” on page 171

“To Load User-Defined Symbols” on page 171

To Create User-Defined Symbols

1. Under the Symbol tab, select the User Defined tab.

2. Select the label name you want to define symbols for.

@

At the bottom of the User Defined tab, type a symbol name in the entry
field.

Select a numeric base.

Select Pattern or Range type for the symbol.

Enter values for the pattern or range the symbol will represent.
Click Add.

Repeat steps 3 through 7 for additional symbols.

© X N o e

You can edit your list of symbols by using Replace (see page 170) and
Delete (see page 171), if desired.

See Also “Using Symbols In The Logic Analyzer” on page 165

To Replace User-Defined Symbols

1. Under the Symbol tab, select the User Defined tab.

2. Select the label you want to replace symbols for.
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3. Select the symbol to replace.

4. At the bottom of the User Defined tab, modify the symbol name, numberic
base, Pattern/Range type, and value, as desired.

5. C(lick the Replace button.

6. Repeat steps 3 through 5 to replace other symbols, if desired.

To Delete User-Defined Symbols

1. Under the Symbol tab, select the User Defined tab.
Select the label you want to delete symbols from.
Select the symbol to delete.

Click the Delete button.

AR

Repeat steps 3 and 4 to delete other symbols, if desired.

See Also

To Load User-Defined Symbols

If you have already saved a configuration file, and the configuration
included user-defined symbols, load the file with its symbols, as
follows:

1. In the menu bar of your analyzer window, click File and then Load
Configuration....

2. In the Load Configuration dialog, select the directory and filename to be
loaded.

3. Select the target of the load operation.

4. Click Load.
User-defined symbols that were resident in the logic analyzer when the
configuration was saved are now loaded and ready to use.

“Using Symbols In The Logic Analyzer” on page 165
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Using the Target Control Port

The Target Control Port is an 8-bit, TTL port that you can use to send
signals to your target system. It does not function like a pattern
generator, but more like a remote control for the target’s switches.

Connecting the Target Control

The target control cable is keyed, so it can be inserted only one way.
Plug it into the target control port with the key up and the cable
hanging down.

The lines are color-coded. Bit 0 is brown, bit 1 is red, bit 2 is orange,
and so on up to bit 7 (grey). The black and white lines are both ground.
Pins 0, 2, 4, and 6 are on the top of the connector and arranged in the
same order as the lines.

If you plan on using Open Collector, remember to install pull-up
resistors. The minimum pull-up resistor is 350 * and the maximum sink
current into the Target Control Port is 12 mA.

Resetting Your Target System

This example also applies to other types of signals you may want to
send to your target system. The reset line in this case is active low.
Open collector is specified so the line is only pulled low when you
activate the signal.

1. Attach the target control cable to the reset line, using proper termination.
2. Set up alabel, RESET.

3. Set the value to 1, for high impedance.
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4. Set Output Drive to Open Collector.
5. When the target needs to be reset manually, click Pulse.

Output Level

| Res
Label 7E543210 Output Drive Set Toggle Fulse St

RESET

““““ Dpen EollECtDPIE‘A Il_ IE‘ Toggle Pulse 1
ﬁ AEE Do a1 - f .

About Open Collector and Active Drive

Open Collector functions as a tri-state, with a logic "1" being high-
impedance, and a logic "0" sinking a current of up to 12 milliamps.

Active Drive puts out a standard TTL signal with 1 high and 0 low.

Both of these signal types must be properly terminated to function
properly. This is especially important for edge-sensitive circuitry.

About Toggle and Pulse

Toggle will flip the settings of the signal and leave them that way. For
example, if your signal is set to 1 and you click Toggle, the setting
changes to 0.

Pulse flips the settings for one clock cycle, at least 16 ms. The pulse
may last longer. You cannot specify the duration of the pulse.
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To Add a Tool

To Delete a Tool

See Also
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Adding and Deleting Tools

The add operation is also done for you automatically when you select an
Instrument Icon (see the HP 16600A/16700A Logic Analysis System help
volume) from the System window. For an overview on the automatic
configuration of measurements, refer to Overview - Starting a New
Measurement (see the HP 16600A/16700A Logic Analysis System help
volume).

1. Point to the new tool in the toolbox, then drag and drop the new tool on
top of any current tool in the measurement setup.
New tools that are dropped on top of a current tool are automatically
connected to the measurement.

1. Point to the tool you want to delete.

2. Right-click the mouse and select Delete.

Setup...
“ Run ALl

About, ..

Delete

&l

“Clearing the Workspace” on page 176
“Connecting Tools Together” on page 175

“Repositioning Tools in the Workspace” on page 177
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Connecting Tools Together

If you drag and drop tools into open space in the workspace, you must
create a data path between the tools by connecting their output and
input ports.

O In

w “u
-

\ Lister <1>

1. Point to the tool output port.

MACHINE 1

2. Press and hold the left mouse button, then move the cursor over to a tool
input port.

3. Release the left button.
You should now have a line, representing a data path, drawn between tool
data ports.
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Clearing the Workspace

Use the Clear Workspace option to remove all Instrument, Display,

Analysis, and Utility tools from the workspace.

1. In the main window menu bar, click File, then select Clear Workspace.
The Clear Workspace option does not clear parameter settings within the

tools. To clear the Workspace and reset all parameters within the tools back to
the defaults, exit out of the system and start a new session.
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Repositioning Tools in the Workspace

Once tools are placed on the workspace (see the HP 16600A/16700A
Logic Analysis System help volume), you can reposition them to help
you visualize your measurement, or to reveal their input and output
ports for connection into the measurement.

To Reposition a Single

Tool H&h\@

MACHINE 1

1. Point to the tool to move.

2. Drag and drop the tool on its new location.

To Reposition

Multiple Tools E}

MACHINE 1 Lister <22

3 e

Lister <1>

1. Press and hold the Shift key, then point and click on all tools to move.

2. Press and hold the Shift key, then drag and drop the group of tools to their
new location.
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absolute Denotes the time period
or count of states between a captured
state and the trigger state. An
absolute count of -10 indicates the
state was captured ten states before
the trigger state was captured.

acquisition Denotes one complete
cycle of data gathering by a
measurement module. For example,
if you are using an analyzer with
128K memory depth, one complete
acquisition will capture and store
128K states in acquisition memory.

analysis probe A probe connected
to the target microprocessor. It
provides an interface between the
signals of the target microprocessor
and the inputs of the logic analyzer.
Also called a "preprocessor".

analyzer 1 In alogic analyzer with
two machines, refers to the machine
that is on by default. The default
name is Analyzer<N>, where N is
the slot letter.

analyzer 2 In a logic analyzer with
two machines, refers to the machine
that is off by default. The default
name is Analyzer<N2>, where N is
the slot letter.

arming An instrument tool must be
armed before it can search for its
trigger condition. Typically,

instruments are armed immediately
when Run or Group Run is selected.
You can set up one instrument to arm
another using the Imtermodule
Window. In these setups, the second
instrument cannot search for its
trigger condition until it receives the
arming signal from the first
instrument. In some analyzer
instruments, you can set up one
analyzer machine to arm the other
analyzer machine in the Trigger
Window.

asterisk (*) See edge terms,
glitch, and labels.

bits Bits represent the physical logic
analyzer channels. A bit is a channel
that has or can be assigned to a label.
A bit is also a position in a label.

card This refers to a single
instrument intended for use in the
HP 16600A-series or HP 16700A
mainframe. One card fills one slot in
the mainframe. A module may
comprise a single card or multiple
cards cabled together.

channel The entire signal path from
the probe tip, through the cable and
module, up to the label grouping.

click To click an item, position the
cursor over the item. Then quickly
press and release the left mouse
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button.

clock channel A logic analyzer
channel that can be used to carry the
clock signal. When it is not needed
for clock signals, it can be used as a
data channel, except in the

HP 16517A.

context record A context record is
a small segment of analyzer memory
that stores an event of interest along
with the states that immediately
preceded it and the states that
immediately followed it.

context store If your analyzer can
perform context store
measurements, you will see a button
labeled Context Store under the
Trigger tab. Typical context store
measurements are used to capture
writes to a variable or calls to a
subroutine, along with the activity
preceding and following the events. A
context store measurement divides
analyzer memory into a series of
context records. If you have a 64K
analyzer memory and select a 16-
state context, the analyzer memory is
divided into 4K 16-state context
records. If you have a 64K analyzer
memory and select a 64-state
context, the analyzer memory will be
divided into 1K 64-state records.

count The count function records

periods of time or numbers of state
transactions between states stored in
memory. You can set up the analyzer
count function to count occurrences
of a selected event during the trace,
such as counting how many times a
variable is read between each of the
writes to the variable. The analyzer
can also be set up to count elapsed
time, such as counting the time spent
executing within a particular function
during a run of your target program.

cross triggering Using intermodule
capabilities to have measurement
modules trigger each other. For
example, you can have an external
instrument arm a logic analyzer,
which subsequently triggers an
oscilloscope when it finds the trigger
state.

data channel A channel that
carries data. Data channels cannot be
used to clock logic analyzers.

data field A data field in the pattern
generator is the data value associated
with a single label within a particular
data vector.

data set A data set is made up of all
labels and data stored in memory of
any single analyzer machine or
instrument tool. Multiple data sets
can be displayed together when
sourced into a single display tool. The
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Filter tool is used to pass on partial
data sets to analysis or display tools.

debug mode See monitor.

delay The delay function sets the
horizontal position of the waveform
on the screen for the oscilloscope and
timing analyzer. Delay time is
measured from the trigger point in
seconds or states.

demo mode An emulation control
session which is not connected to a
real target system. All windows can
be viewed, but the data displayed is
simulated. To start demo mode,
select Start User Session from the
Emulation Control Interface and
enter the demo name in the
Processor Probe LAN Name field.
Click Help in the Start User Session
window for details.

deskewing To cancel or nullify the
effects of differences between two
different internal delay paths for a
signal. Deskewing is normally done
by routing a single test signal to the
inputs of two different modules, then
adjusting the Intermodule Skew so
that both modules recognize the
signal at the same time.

don’t care For terms, a "don’t care"
means that the state of the signal
(high or low) is not relevant to the

measurement. The analyzer ignores
the state of this signal when
determining whether a match occurs
on an input label. "Don’t care" signals
are still sampled and their values can
be displayed with the rest of the data.
Don’t cares are represented by the X
character in numeric values and the
dot (.) in timing edge specifications.

dot (.) See edge terms, glitch,
labels, and don’t care.

double-click To double-click an
item, position the cursor over the
item, and then quickly press and
release the left mouse button twice.

drag and drop To drag and drop an
item, position the cursor over the
item, and then press and hold the left
mouse button. While holding the left
mouse button down, move the mouse
to drag the item to a new location.
When the item is positioned where
you want it, release the mouse
button.

edge mode In an oscilloscope, this
is the trigger mode that causes a
trigger based on a single channel
edge, either rising or falling.

edge terms Logic analyzer trigger
resources that allow detection of
transitions on a signal. An edge term
can be set to detect a rising edge,
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falling edge, or either edge. Some
logic analyzers can also detect no
edge or a glitch on an input signal.
Edges are specified by selecting
arrows. The dot (.) ignores the bit.
The asterisk (¥) specifies a glitch on
the bit.

emulation module A module
within the logic analysis system
mainframe that provides an
emulation connection to the debug
port of a microprocessor. An E5901A
emulation module is used with a
target interface module (TIM) or an
analysis probe. An E5901B emulation
module is used with an E5900A
emulation probe.

emulation probe The stand-alone
equivalent of an emulation module.
Most of the tasks which can be
performed using an emulation
module can also be performed using
an emulation probe connected to
your logic analysis system via a LAN.

emulator An emulation module or
an emulation probe.

Ethernet address See link-level
address.

events Events are the things you
are looking for in your target system.
In the logic analyzer interface, they
take a single line. Examples of events

are Labell = XX and Timer 1 > 400
ns.

filter expression The filter
expression is the logical OR
combination of all of the filter terms.
States in your data that match the
filter expression can be filtered out or
passed through the Pattern Filter.

filter term A variable that you
define in order to specify which
states to filter out or pass through.
Filter terms are logically OR’ed
together to create the filter
expression.

Format The selections under the
logic analyzer Format tab tell the
logic analyzer what data you want to
collect, such as which channels
represent buses (labels) and what
logic threshold your signals use.

frame The HP 16600A-series or
HP 16700A logic analysis system
mainframe. See also logic analysis
system.

gateway address An IP address
entered in integer dot notation. The
default gateway address is 0.0.0.0,
which allows all connections on the
local network or subnet. If
connections are to be made across
networks or subnets, this address
must be set to the address of the
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gateway machine.

glitch A glitch occurs when two or
more transitions cross the logic
threshold between consecutive
timing analyzer samples. You can
specify glitch detection by choosing
the asterisk (*) for edge terms under
the timing analyzer Trigger tab.

grouped event A grouped event is
a list of events that you have
grouped, and optionally named. It can
be reused in other trigger sequence
levels. Only available in HP 16715A,
16716A, and 16717A logic analyzers.

held value A value that is held until
the next sample. A held value can
exist in multiple data sets.

immediate mode In an
oscilloscope, the trigger mode that
does not require a specific trigger
condition such as an edge or a
pattern. Use immediate mode when
the oscilloscope is armed by another
instrument.

interconnect cable Short name for
module/probe interconnect cable.

intermodule Intermodule is a term
used when multiple instrument tools
are connected together for the
purpose of one instrument arming
another. In such a configuration, an

arming tree is developed and the
group run function is designated to
start all instrument tools. Multiple
instrument configurations are done in
the Intermodule window.

intermodule bus The intermodule
bus (IMB) is a bus in the frame that
allows the measurement modules to
communicate with each other. Using
the IMB, you can set up one
instrument to arm another. Data
acquired by instruments using the
IMB is time-correlated.

internet address Also called
Internet Protocol address or IP
address. A 32-bit network address. It
is usually represented as decimal
numbers separated by periods; for
example, 192.35.12.6. Ask your LAN
administrator if you need an internet
address.

labels Labels are used to group and
identify logic analyzer channels. A
label consists of a name and an
associated bit or group of bits. Labels
are created in the Format tab.

line numbers A line number (Line
#s) is a special use of symbols. Line
numbers represent lines in your
source file, typically lines that have
no unique symbols defined to
represent them.
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link-level address Also referred to
as the Ethernet address, this is the
unique address of the LAN interface.
This value is set at the factory and
cannot be changed. The link-level
address of a particular piece of
equipment is often printed on a label
above the LAN connector. An
example of a link-level address in
hexadecimal: 0800090012AB.

local session A local session is
when you run the logic analysis
system using the local display
connected to the product hardware.

logic analysis system The

HP 16600A-series or HP 16700A
mainframe, and all tools designed to
work with it. Usually used to mean
the specific system and tools you are
working with right now.

machine Some logic analyzers allow
you to set up two measurements at
the same time. Each measurement is
handled by a different machine. This
is represented in the Workspace
window by two icons, differentiated
by a I and a € in the upper right-hand
corner of the icon. Logic analyzer
resources such as pods and trigger
terms cannot be shared by the
machines.

markers Markers are the green and
yellow lines in the display that are

labeled &, 0, G1, and G2. Use them to
measure time intervals or sample
intervals. Markers are assigned to
patterns in order to find patterns or
track sequences of states in the data.
The x and o markers are local to the
immediate display, while G1 and G2
are global between time correlated
displays.

master card In a module, the
master card controls the data
acquisition or output. The logic
analysis system references the
module by the slot in which the
master card is plugged. For example,
a b-card HP 16555D would be
referred to as Slot C: machine
because the master card is in slot C of
the mainframe. The other cards of
the module are called expansion
cards.

menu bar The menu bar is located
at the top of all windows. Use it to
select File operations, tool or system
Options, and tool or system level
Help.

message bar The message bar
displays mouse button functions for
the window area or field directly
beneath the mouse cursor. Use the
mouse and message bar together to
prompt yourself to functions and
shortcuts.
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module An instrument that uses a
single timebase in its operation.
Modules can have from one to five
cards functioning as a single
instrument. When a module has more
than one card, system window will
show the instrument icon in the slot
of the master card.

module/probe interconnect cable

The module/probe interconnect cable
connects an E5901B emulation
module to an E5900B emulation
probe. It provides power and a serial
connection. A LAN connection is also
required to use the emulation probe.

monitor When using the Emulation
Control Interface, running the
monitor means the processor is in
debug mode (that is, executing the
debug exception) instead of
executing the user program.

panning The action of moving the
waveform along the timebase by
varying the delay value in the Delay
field. This action allows you to
control the portion of acquisition
memory that will be displayed on the
screen.

pattern mode In an oscilloscope,
the trigger mode that allows you to
set the oscilloscope to trigger on a
specified combination of input signal

levels.

pattern terms Logic analyzer
resources that represent single states
to be found on labeled sets of bits; for
example, an address on the address
bus or a status on the status lines.

period (.) See edge terms, glitch,
labels, and don’t care.

pod See pod pair

pod pair A group of two pods
containing 16 channels each, used to
physically connect data and clock
signals from the unit under test to the
analyzer. Pods are assigned by pairs
in the analyzer interface. The number
of pod pairs avalaible is determined
by the channel width of the
instrument.

point To point to an item, move the
mouse cursor over the item.

preprocessor See analysis probe.

primary branch The primary
branch is indicated in the Trigger
sequence step dialog box as either
the Then find or Trigger on
selection. The destination of the
primary branch is always the next
state in the sequence, except for the
HP 16517A. The primary branch has
an optional occurrence count field
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that can be used to count a number of
occurrences of the branch condition.
See also secondary branch.

probe A device to connect the
various instruments of the logic
analysis system to the target system.
There are many types of probes and
the one you should use depends on
the instrument and your data
requirements. As a verb, "to probe"
means to attach a probe to the target
system.

processor probe See emulation
probe.

range terms Logic analyzer
resources that represent ranges of
values to be found on labeled sets of
bits. For example, range terms could
identify a range of addresses to be
found on the address bus or a range
of data values to be found on the data
bus. In the trigger sequence, range
terms are considered to be true when
any value within the range occurs.

relative Denotes time period or
count of states between the current
state and the previous state.

remote display A remote display is
a display other than the one
connected to the product hardware.
Remote displays must be identified to
the network through an address

location.

remote session A remote session is
when you run the logic analyzer using
a display that is located away from
the product hardware.

right-click To right-click an item,
position the cursor over the item, and
then quickly press and release the
right mouse button.

sample A data sample is a portion of
a data set, sometimes just one point.
When an instrument samples the
target system, it is taking a single
measurement as part of its data
acquisition cycle.

Sampling Use the selections under
the logic analyzer Sampling tab to tell
the logic analyzer how you want to
make measurements, such as State
vs. Timing.

secondary branch The secondary
branch is indicated in the Trigger
sequence step dialog box as the Else
on selection. The destination of the
secondary branch can be specified as
any other active sequence state. See
also primary branch.

session A session begins when you
start a local session or remolte
sesston from the session manager,
and ends when you select Exit from
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the main window. Exiting a session
returns all tools to their initial
configurations.

skew Skew is the difference in
channel delays between
measurement channels. Typically,
skew between modules is caused by
differences in designs of
measurement channels, and
differences in characteristics of the
electronic components within those
channels. You should adjust
measurement modules to eliminate
as much skew as possible so that it
does not affect the accuracy of your
measurements.

state measurement In a state
measurement, the logic analyzer is
clocked by a signal from the system
under test. Each time the clock signal
becomes valid, the analyzer samples
data from the system under test.
Since the analyzer is clocked by the
system, state measurements are
synchronous with the test system.

store qualification Store
qualification is only available in a
state measurement, not timing
measurements. Store qualification
allows you to specify the type of
information (all samples, no samples,
or selected states) to be stored in
memory. Use store qualification to
prevent memory from being filled

with unwanted activity such as no-
ops or wait-loops. To set up store
qualification, use the While storing
field in a logic analyzer trigger
sequence dialog.

subnet mask A subnet mask blocks
out part of an IP address so that the
networking software can determine
whether the destination host is on a
local or remote network. It is usually
represented as decimal numbers
separated by periods; for example,
255.255.255.0. Ask your LAN
administrator if you need a the
subnet mask for your network.

symbols Symbols represent
patterns and ranges of values found
on labeled sets of bits. Two kinds of
symbols are available:

e (Object file symbols - Symbols
from your source code, and
symbols generated by your
compiler. Object file symbols may
represent global variables,
functions, labels, and source line
numbers.

e User-defined symbols - Symbols
you create.

Symbols can be used as pattern and
range terms for:

e Searches in the listing display.
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e Triggering in logic analyzers and
in the source correlation trigger
setup.

e (Qualifying data in the filter tool
and system performance analysis
tool set.

system administrator The system
administrator is a person who
manages your system, taking care of
such tasks as adding peripheral
devices, adding new users, and doing
system backup. In general, the
system administrator is the person
you go to with questions about
implementing your software.

target system The system under
test, which contains the
microprocessor you are probing.

terms Terms are variables that can
be used in trigger sequences. A term
can be a single value on a label or set
of labels, any value within a range of
values on a label or set of labels, or a
glitch or edge transition on bits
within a label or set of labels.

TIM A TIM (Target Interface
Module) makes connections between
the cable from the emulation module
or emulation probe and the cable to
the debug port on the system under
test.

timer terms Logic analyzer
resources that are used to measure
the time the trigger sequence
remains within one sequence step, or
a set of sequence steps. Timers can
be used to detect when a condition
lasts too long or not long enough.
They can be used to measure pulse
duration, or duration of a wait loop. A
single timer term can be used to
delay trigger until a period of time
after detection of a significant event.

time-correlated Time correlated
measurements are measurements
involving more than one instrument
in which all instruments have a
common time or trigger reference.

timing measurement In a timing
measurement, the logic analyzer
samples data at regular intervals
according to a clock signal internal to
the timing analyzer. Since the
analyzer is clocked by a signal that is
not related to the system under test,
timing measurements capture traces
of electrical activity over time. These
measurements are asynchronous
with the test system.

tools A toolis a stand-alone piece of
functionality. A tool can be an
instrument that acquires data, a
display for viewing data, or a post-
processing analysis helper. Tools are
represented as icons in the main
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window of the interface.

toolbox The Toolbox is located on
the left side of the main window. It is
used to display the available
hardware and software tools. As you
add new tools to your system, their
icons will appear in the Toolbox.

tool icon Tool icons that appear in
the workspace are representations of
the hardware and software tools
selected from the toolbox. If they are
placed directly over a current
measurement, the tools automatically
connect to that measurement. If they
are placed on an open area of the
main window, you must connect them
to a measurement using the mouse.

trace See acquisition.

trigger Trigger is an event that
occurs immediately after the
instrument recognizes a match
between the incoming data and the
trigger specification. Once trigger
occurs, the instrument completes its
acquisition, including any store
qualification that may be specified.

trigger sequence A trigger
sequence is a sequence of events that
you specify. The logic analyzer
compares this sequence with the
samples it is collecting to determine
when to trigger.

trigger specification A trigger
specification is a set of conditions
that must be true before the
instrument triggers.

workspace The workspace is the
large area under the message bar and
to the right of the toolbox. The
workspace is where you place the
different instrument, display, and
analysis tools. Once in the workspace,
the tool icons graphically represent a
complete picture of the
measurements.

zooming In the oscilloscope or
timing analyzer, to expand and
contract the waveform along the time
base by varying the value in the s/Div
field. This action allows you to select
specific portions of a particular
waveform in acquisition memory that
will be displayed on the screen. You
can view any portion of the waveform
record in acquisition memory.
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A

account, 51

accounts, 16

active drive, 172

add, 174

adjust skew, 112

alias, network IP addresses, 21

Align to x Byte option, 169

Align to x Byte option for symbols,
169

altitude, 94

analysis, tab, 111

analyzer example, 130

analyzer probes, general-purpose,
144

analyzer probes, termination
adapter, 144

ASCII format, 158

ASCII format symbols, 158, 159,
160, 161, 162

ASCII symbol file, 161

auto arrange icons, 14

autoload, 64

B

beyond prefetch depth, 169
browse hosts, 33

browse local, 33

browser dialog, 165

browser, symbol search, 165
browsing, 168

browsing the symbol database, 168

C

calibration, 95

cancel, 147

characteristic, 94

characteristics, 93

chart, 73

clearing the workspace, 176

clock, set time date, 16

code, assigning address offsets, 156

comments, 162

compare tool, 73

compress, file, 67

config, option, 85

connecting tool input and output
ports, 175

connector, 119

copy, file, 65

correlation, 109

creating a file, 158

creating ASCII symbol files, 158

customer comments, 91

D

data communications analysis, 73

data displayed in symbolic form,
153

data files, 78

data, option, 85

date, setting, 43

default, 68

definition, 94, 95

delete, 174

delete, directory, 64

delete, file, 66

demand driven data, 150

description, 61

deskew, 112

directories, 68

directories, delete, 64

directories, make, 64

directories, rename, 65

directory, 68

disable, network, 17

disable/enable run status window,
149

disk, format, 69

displaying symbols to represent
data, 153

distribution, 73

documentation feedback, 91

domain name, 25

E

ELF/DWAREF file format, 157

ELF/stabs file format, 157

emulation probe, network setup,
20

enable, network, 17

environmental, 94

example, 130, 159, 168, 169

example measurements, 138, 140

expand, 101

expansion, 101

external hard drive, 70

external, trigger, 119

F

faxable prints, 42

file, 64, 81, 82

file extensions, 78

file formats for ASCII symbols, 158

file in, 73

file manager, 63, 69

file operations, 63

file out, 73

file permissions, default, 86

file system, NF'S mount, 30

file transfer protocol, 34

file types, 78

file versions, 154

files, 154

files, loading user-defined symbol
files, 171

filesystems, 16

finding the symbol you want, 168

flexible, 69

floppy, 69

frame, 101

ftp, 34

function test, 95

functions, 160

G
gateway address, 17
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gateway ip, 20
gateway name, 17, 19
grid lines, 14

group run, 147

H

hard drive, 70

help, 73, 143

help on world wide web, 91
help resources, 91

help system organization, 95
help, characteristics, 94
help, localized versions, 73
help, specifications, 94

help, symbols, 152

host table, 21

hostname, 17, 19

HP 16517A logic analyzer, 73
HP 16518A logic analyzer, 73
HP 16522A pattern generator, 73
HP 16533A oscilloscope, 73
HP 16534A oscilloscope, 73
HP 16550A logic analyzer, 73
HP 16554A logic analyzer, 73
HP 16555A logic analyzer, 73
HP 16555D logic analyzer, 73
HP 16556A logic analyzer, 73
HP 16556D logic analyzer, 73
HP 16557D logic analyzer, 73
HP 16710A logic analyzer, 73
HP 16711A logic analyzer, 73
HP 16712A logic analyzer, 73
HP 16715A logic analyzer, 73
HP 16716A logic analyzer, 73
HP 16717A logic analyzer, 73
HP 16718A logic analyzer, 73
HP 16719A logic analyzer, 73
humidity, 94

I

IEEE-695 file format, 157
IMB, 112, 119

import, user accounts file, 51

in ASCII format, 160, 161, 162

in symbol browser, 168

increment filenames, 42

independent run, 147

install, 59

install, software, 16

instrument, 73

interface, 61

intermodule, 112, 123, 130, 138,
140

internet address, 17

internet address (IP), 19

ip, 19

J

Japanese localized help, 99
Japanese translated help, 99

L

license, 36

licensing, 16

licensing, policy, 36

line numbers, 161

list, 60

list, software, 16

listing, 73

load, 84

load configuration files, 81, 82

load, system settings, 45

loading, 154

loading config files, overview, 78

loading files including symbols, 154

loading object file symbols, 154

loading user-defined symbol files,
171

local, 38

logic analyzer path field, 25

logic analyzer probes, 144

login, 34, 35

login information fields, 25

M

machine, 130

make, directory, 64

masking off addresses of symbols,
169

measurement, 138, 140

measurement, probing options, 144

measurement, run options, 147

measurements, start, 77

mixed signal, 109

mount, 70

mount, directory, 16

move, file, 66

moving tools around the
workspace, 177

N

name resolver, network, 21
names, network, 21
netbios, 26

network, 25, 38

network setup, 16
network, printer setup, 40
NFS, 16, 30

nodelock mode, 36

NT, 16, 22, 27

NT, server, 40

o

object file symbol browser, 165

object file symbol files, 154

object file symbols, 165, 168

odd-numbered addresses, 169

odd-numbered addresses
represented by symbols, 169

offset, 169

offset addresses, assigning, 156

Offset By option of the symbol
browser, 169

OMF96 file format, 157

OMFx86 file format, 157

open collector, 172
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operating characteristics, 93
operating environment, 94
option, load, 85

option, save, 85

options, print destination, 41
options, run, 147
oscilloscope example, 123
overview, 61, 72, 140

P

passwd, 54

password, 16, 57

password, age, 54

password, form, 53

path, 25

Pattern field, 168

pattern filter, 73

pc connectivity, 73

pentium, 73

performance verification, 43, 44

ping, 16, 36

pixel mapping, faxable prints, 42

pk, 67

pkunzip, 67, 68

pkzip, 67, 68

port in, 119

port out, 119

prefetch, 169

preprocessor, see analysis probe,
108

print, 38, 40, 42

print, to file, 41

print, windows and configurations,
37

printer, 37, 41

printer, setup, 38

printers, setup, 16

printing, 37

privileges, 18

probe leads, 144

probes, individual signal, 144

probing, overview, 144

processor probe, see emulation
probe, 108

product, 72

proxy, 18

pv, 43, 44

R

readers.ini file, 163

reboot, 45

reconnect at startup, 24
record headers, 159
recover, system settings, 45
refresh, 69

registration, 36

re-ignite, 45

relocating sections of code, 156
remote, 34

remote drives, 22, 27
remove, 59

remove, software, 16
rename, directory, 65
rename, file, 66

repetitive, 147

repetitive data display, 150
repositioning tools, 177
results, 168

root, 18

run, 147

run control, 73

run options, 149

run status, checking, 149
run status, disable window, 149

S

save window prints,
autoincrement, 42

save, system settings, 45

saving config files, overview, 78

saving configuration files, 83

screen saver, 14

Scroll Files field, 165

Search Pattern field, 168

searching the symbol database, 168
sections, 160

secure mode, 51, 86
security, 16

self test, 43, 44

self tests, 16

serial analysis, 73
server, 26

session control, 86
session manager, 89
session, close, 89
session, remote, 35
session, shutdown, 89
session, start, 89

setting default file permissions, 86
share, 27

share comment, 30
share name, 29

share password, 25, 30
share, directory, 16
simple example, 158
simple form, 158

single, 147

snap, 14

software, 16, 59, 60
software analyzer, 73
source line numbers, 161
spa, 73

specification, 94
specifications, 93

start address, 160

state analyzer, 73
status, 149

stimulus, 73

stop, 147

subnet mask, 17, 20
swa, 73

symbol demangling, 163
symbol file formats, 157
symbol file versions, 154
symbol selector dialog, 167, 168
symbol type, 165
symbol types, 165
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symbols, 168

symbols, displaying to represent
data, 153

symbols, how they are used in the
logic analyzer, 165

symbols, loading object file
symbols, 154

symbols, loading user-defined
symbol files, 171

symbols, setting up, 154

symbols, types and use, 152

symbols, user-defined details, 170

system administration, 16

system administrator, 18, 86

system clock, 43

system default file permissions, 88

system overview, 93

system performance analysis, 73

system settings, load, 45

system settings, save, 45

system terminology, 108

system terms, 108

T

tab, analysis, 111

tab, mixed signal, 109

tab, symbols, 152

target, 84

target control port, 172

target control, pinout, 172
target, resetting, 172

tasks, system administration, 16
telnet, 16, 35

temperature, 94

TI COFF file format, 157

time, setting, 43

timing analyzer, 73

timing analyzer example, 123
tool sets, 36

tools, 36

tools, adding and deleting, 174
tools, connecting, 175

tools, repositioning, 177

trademark, 68

trigger term, 165, 169

trigger, external, 119

triggering beyond, 169

triggering on a symbol, 165, 168,
169

U

uncompress, file, 67

update, 59

update, software, 16

user account name, 25

user accounts, 18, 86

user environment, description, 86

User Symbols, 165

user-defined symbol files, loading,
171

user-defined symbols, details, 170

A%

variables, 162
versions, 154
versions of symbol files, 154
vibration, 94

w

waveform, 73

web help information, 91
wildcard characters, 168
windows, 16, 22, 27, 40
work files, 78

workspace, 14

workspace, clearing the, 176

Z
zip, 67, 68

194



	System: HP�16600A/16700A Logic Analysis System
	HP�16600A/16700A Series Logic Analysis System
	Contents
	HP�16600A/16700A Series Logic Analysis System
	The Intermodule Window
	The Workspace Window
	Workspace Options

	The System Administration Tools
	Configuring the Network
	System Administration Privileges
	Hostname
	Internet Address (IP)
	Gateway Name
	Gateway IP
	Subnet Mask
	Emulation Network Setup

	Using the Name Resolver to Alias IP Addresses
	Mapping Windows/NT Network Drives
	Reconnect at Startup
	Network Path
	Logic Analyzer Directory Path
	Login Information
	Naming Server and Client Netbios Names

	Share Analyzer Drive
	Share Name
	Share Comment
	Using a Share Password

	Configuring the NFS
	Remote Host
	Remote Directory Path
	Local Directory Path
	Options
	Using Browse Hosts
	Using Browse Local

	FTP (file transfer protocol)
	Telnet
	Ping
	Licensing Policy for the Logic Analysis System
	Printing Windows - Configurations
	Printer Setup
	Windows NT Server Configuration

	Print Options
	Autoincrement filenames
	Pixel mapping

	Configuring the System Clock
	Running the Self Tests
	More on Self Tests

	Saving and Reloading System Settings
	Re-ignite Procedure
	Printer Settings
	Network Settings
	User Accounts
	Licenses
	Custom Colors
	Web Settings
	Session Manager Settings
	E-mail on Trigger Settings

	Setting Up User Accounts
	Legal Passwords
	Passwd Man Page

	Change Password
	Web Server Security
	Shared Console (VNC) Security
	Remote Programming Interface Security
	pcnfsd (For PC NFS) Security
	Install Software
	Remove Installed Software
	List Installed Software

	The User Interface - Icons, Tabs, and Navigation
	File Management Tools
	Autoloading a File
	Make a Directory
	Delete a Directory
	Rename a Directory
	Copy a File
	Delete a File
	Move a File
	Rename a File
	Compressing Files - PKZIP
	More About PKZIP

	Default Directory Descriptions
	Format a Floppy Disk
	Refresh the File Manager
	Mounting an External Hard Drive

	Product Description
	Master List of All Tool Help Volumes
	Overview - Starting a New Measurement
	Loading & Saving Configuration Files
	File Types
	What Gets Loaded
	Other File Types

	Loading Configuration Files
	Target for the Load File Operation

	Saving Configuration Files
	Source for the Save File Operation
	Config and Data/Config Only Option

	The User Environment and Session Control
	About File Permissions
	Starting a Session

	Available Help Resources
	Information on the Web

	System Overview
	Frame Specifications and Characteristics
	What is a Specification
	What is a Characteristic
	What is a Calibration Procedure
	What is a Function Test
	How the Help System is Organized

	Making Measurements
	The Run Status Window
	Japanese Help Volumes
	Using the HP�16701A Expansion Frame
	The System Window
	Navigation with Tabs
	Navigation with the Icon Bar
	Automatic Measurement Configuration
	Accessing Display Tools
	System Terminology
	Using the Mixed Signal Tab
	Using the Correlation Dialog
	Using the Analysis Tab
	Adjusting Intermodule Skew
	Configure the Timing Analyzer
	Configure the Oscilloscope
	Configure the Group Run Arming Tree
	Configure the Waveform Display
	Placing Markers for an Interval Reading.
	Adjust the Skew

	Starting Measurements from External Triggers
	Using a Timing Analyzer and an Oscilloscope
	Configure the Oscilloscope
	Configure the Logic Analyzer
	Configure the Group Run Arming Tree
	Importing Signals into the Display

	Using Both Analyzers
	Configure the Timing Analyzer
	Configure the State Analyzer
	Configure the Arming Tree

	Group Run Arming Tree
	Arming Tree
	Overview - Multiple Analyzer Configuration
	Overview - Multiple Instrument Configuration
	Count Field
	Help - How to Navigate Quickly
	Analyzer Probing Overview
	Run/Group Run Function
	Setting a tool for independent or Group Run
	Setting Single or Repetitive Run
	Checking Run Status
	Demand Driven Data

	The Symbols Tab
	Displaying Data in Symbolic Form
	Setting Up Object File Symbols
	To Load Object File Symbols
	Relocating Sections of Code
	To Delete Object File Symbol Files
	Symbol File Formats
	Creating ASCII Symbol Files
	Simple Format
	Record Header Format
	Start Address
	Functions
	Sections
	Source Line Numbers
	Variables
	Comments


	Creating a readers.ini File

	Using Symbols In The Logic Analyzer
	Using Symbols As Trigger Terms
	Using Symbols as Search Patterns in Listing Displays
	Using Symbols as Trigger Terms in the Source Viewer
	Using Symbols as Pattern Filter Terms
	Using Symbols as Ranges in the Software Performance Analyzer
	Using the Symbol Selector Dialog
	Using the Symbol Selector Dialog
	Search Pattern
	Align to x Byte Option
	Offset By Option


	User-Defined Symbols
	To Create User-Defined Symbols
	To Replace User-Defined Symbols
	To Delete User-Defined Symbols
	To Load User-Defined Symbols

	Using the Target Control Port
	Adding and Deleting Tools
	Connecting Tools Together
	Clearing the Workspace
	Repositioning Tools in the Workspace


	Glossary
	Index


